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INSTALLATION PACKAGE 
" 

The basic WATERS installation package contains the following: 

• One WATERS Program Diskette (EPA 813-C-93-001) 
• One GIS Data Diskette (see specific EPA order numbers below) 
• one User Guide (EPA 813-8-93-002, October 1993) 

If you wish to use the optional WATERS Mapping System (WMS), you must also 
obtain a MapinfoTM runtime module. The runtime module includes several 
diskettes, installation instructions, and user documentation. 

Until February 28, 1994, a runtime module may be purchased at a reduced 
price for the WATERS application from the following MapinfoTM authorized 
developer for $335.75 a copy (current price is $695.00). Payment must 
accompany order. 

American Management Systems, Inc. 
1777 North Kent Street 
Arlington, Virginia 22209 
Attn: Mr. Jerry Golley 

After February 1994, runtime modules may be purchased at the regular 
price through any authorized developer. 

The specific order numbers for the GIS Data Diskette by EPA Region and State 
are listed below. 

Region 

I 
II 

III 
IV 
v 

VI 
VII 

VIII 
IX 
x 

States Included 

CT,ME,MA,NH,RI,VT 
NJ,NY,PR,VI 
DE,DC,MD,PA,VA,WV 
AL,FL,GA,KY,MS,NC,SC,TN 
IL,IN,MI,MN,OH,WI 
AR,LA,NM,OK,TX 
IA,KS,MO,NE 
CO,MT,ND,SD,UT,WY 
AZ,CA,HI,NV,AS,GU, 
A:K,ID,OR,WA 

EPA Publication Number 

813-C-93-002 
813-C-93-003 
813-C-93-004 
813-C-93-005 
813-C-93-006 
813-C-93-007 
813-C-93-008 
813-C-93-009 
813-C-93-010 
813-C-93-011 



WATERS Mapping System Installation Addendum 
(l'1lia it a .ddcadlllll to Otapru ID: llls"'1141Jott llNl Slan-tlp of die WATERS Ua Ouidc) 

To install the MapinfoTMRuntime Module, follow the directions below. 

Step l. 

Step 2. 

Step 3. 

Step 4. 

Step 5. 

Step 6. 

Insert the RUNTIME DISK 1 in Drive A. Then type A.Install. 

When you are asked, Do you wish to install the Napinfo711 

Runtime So~tware?, select yes. 

When asked to confirm the destination path, select .IlQ., and then 
type C: \WATERS\RT. . 

You are instructed to insert Program Disk 1 and press ENTER to 
begin installation. Then prompted for Program Disk 2 and the 
Drivers Diskette. 

When asked, Do you want to see the READ.NE file?, select JlQ· 

When asked Do you wish to specify your hardware configuration?, 
select yes. · 

Step 7. Select the Display, Input, and Output Device. 

Step 8. When asked Do you wish to load any data?, select nQ. 

One of the files created when installing the Mapinfo™ Runtime Module is 
the CGI.CFG file. A copy of this file should always be available for the 
WATERS Mapping System. The file is created from Steps 6-7 above and is the 
configuration file pointed to by the CGIPATH DOS variable. 

When CGI.CFG is not found, an error message is displayed. In such 
cases, the CGI.CFG file may not have been created during installation or 
device configuration was incorrectly assigned. To correct the problem, add 
CGIPATH=C:\WATERS\RT to the AUTOEXEC.BAT file, and then reboot your machine. 

After installation of the Mapinfo™ Runtime Module, the GIS atartup 
displays a warning message indicating that the following files were not found: 

• MAPINFO Help file 
• Pointfile CITY 

To prevent these warnings messages from occurring, use a text editor 
(such as EDIT) to modify the WMS.CNF file located in the WATERS directory. 
Two changes need to be made to this file: 

1) 
2) 
3) 

Delete: 
Change: 
To: 
where C: is 

/H MAPINFO.HLP 
/P D:\WATERS\MAPDATA\CITY 
/P C:\WATERS\MAPDATA\CITY 
the drive WATERS was installed. 
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Version 2.0 
Highlights 

Chapter I. Introduction to WA TEAS 

standard reports to support State/DI program 
management and operation needs. 

The reports may contain information for a single well, 
a group of wells, or all the wells. These reports 
enable you to take full advantage of WATERS' query 
capabilities to determine which wells should be 
included in a report. Some reports also allow you to 
choose the time frame, enabling you to print current 
reports for management purposes, or past reports 
for reference purposes. The Custom Report feature 
allows you to create ad hoc reports. 

EPA designed the WATERS user interface to minimize 
the amount of time you will need to learn and begin 
to use the system. It includes a number of visual 
effects to help you understand what the system is 
doing. It also includes pull-down menus, dialog 
boxes, and on-line help. 

You can easily add to or edit the well data 
contained in the system. In addition, by searching 
for the contents of a specific field (or group of 
fields), you can retrieve information about a well or 
group of wells. 

While WATERS Version 1.0 was designed to track only 
Class II wells, WATERS 2.0 accommodates all UIC 
wells, as well as non-UIC wells. Other new features 
of WATERS 2.0 include: 

• cross-folder searching 

• the ability to add pages and data elements 

" LAN compatibility 

• mapping capabilities with GIS functions 

• ad hoc reporting 

• enhanced copying capabilities 

• enhanced well schematic drawn to scale 

• enhanced features to save and delete queries 

2 WATERS User Guide 
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Organization 

Chapter II. User Guide Overview 

II. User Guide Overview 

This User Guide discusses the features and 
capabilities of WATERS and provides guidanCErtor 
using the system. It is organized so that you have 
two references for WATERS: the chapters and the 
training script (Appendix A). The chapters describe 
functions and features, while the training script 
provides step-by-step examples of many WATERS 
features. 

All new users should review the training script before 
using WATERS. Users familiarwith WATERS can use 
the script as a reference. When appropriate, the 
chapters will provide the page numbers of 
corresponding examples in the training script. 
Similarly, the training script will cite the 
corresponding chapter that has more in-depth 
explanations of each function. 

The User Guide is organized as follows: 

• Chapter Ill discusses the installation package, 
system requirements, installation, program start­

. up, and deleting test data. 

• Chapter IV briefly discusses the basic 
components of WATERS: database modules 
(referred to as folders), menus, and navigation. 

• Chapter V discusses WATERS' folders for UIC and 
non-UIC wells. 

• Chapter VI discusses WATERS' menus. 

• Chapter VII discusses WATERS' query capabilities. 

• Chapter VIII describes the reports available in 
WATERS. 

WATERS User Guide 3 



Fonnatting 
Conventions 

Chapter II. User Guide Overview 

• Chapter IX describes the optional WATER 
Mapping System (WMS). 

• Chapter X discusses the WATERS Screen Editor, 
which allows users to add screens and data 
elements to folders. 

• Chapter XI summarizes the help available for 
WATERS users. 

• Appendix A is a training script that provides step­
by-step instructions for many WATERS features. 

• Appendix B contains the WATERS database and 
field descriptions. 

The WATERS User Guide follows several formatting 
conventions, which are listed below: 

• Text you type into the system is undertined (i.e., 
type Install A:). 

• Buttons you must press appear as boxes (i.e., 
press I Return l) . 

• References to specific data element names are 
in quotes (i.e., enter Y or Nin the "Rule 
Authorized" field). 

• Prompts and messages from the system appear 
in a different font (i.e., c: \WATERS). 

• Items of particular interest are identified as tips. 

4 WATERS User Guide 



Installation 
Package 

Chapter Ill. Installation and Startup 

Ill. Installation and Start-Up 

This chapter describes how to install WATERS on your 
PC or LAN and start the program. 

The basic WATERS installation package contains the 
following: one program diskette and one 
geographic information system (GIS) data diskette. 
If you wish to use the optional WATERS Mapping 
System (WMS), you must also obtain a Maplnfo 
runtime module from EPA Headquarters or Maplnfo 
Corporation. The runtime module includes several 
diskettes. installation instructions. and user 
documentation. 

The WATERS program diskette contains four 
programs: 

• The WATERS program 

This program includes the basic data entry and 
query functions. a test database, and the ability 
to print reports and produce a well schematic. 

• The Screen Editor program 

The Screen Editor enables you to add pages and 
fields to the core WATERS system. 

• The WATERS Mapping System (WMS) 

WMS is an optional program that produces maps 
of the geographic areas surrounding wells 
tracked in WATERS. 

• The WMS Layers program 

The Layers program enables you to add, remove, 
and change the style of geographic features in 
WMS maps. 

WATERS User Guide 5 



WATERS 
System 

Requirements 

Chapter Ill. Installation and Start-Up 

The GIS data diskette contains your region's 
geographical data, which WMS uses to plot maps. 
You must have a Maplnfo runtime module to 
operate the WMS program. However, you can 
install the WMS program prior to obtaining the 
runtime module. 

The WATERS program diskette and the GIS diskette 
are labeled differently so you can easily distinguish 
the two. The program diskette depicts a well 
schematic and the title PROGRAM' DISKETTE above 
the EPA logo. The GIS data diskette depicts a 
compass, the title GIS DATA DISKETTE above the EPA 
logo, and your region number in the upper right 
comer. 

This section describes WATERS' hardware and 
software requirements. Specifically, WATERS Version 
2.0 requires: 

• An IBM or compatible 286 machine (a 386 
machine or higher is recommended) 

• 640K RAM with 570K free 

• At least 3 meg.abytes rMB) of free hard disk 
space 

• An extended keyboard 

• An HP Laser Jet II or Ill or compatible printer 

• A color monitor for correct screen interpretation 

• DOS version 3.30 or greater (version 5.0 or greater 
is preferable} 

See Chapter IX for WMS systems requirements. 

6 WATERS User Guide 



Installing 
WATERS 

Chapter Ill Installation and Startup 

This section describes how to install WATERS and its 
associated programs on a PC or a LAN, and how to 
delete the test data. Generally, the drive which 
accepts diskettes is the A or B drive. Your hard drive 
is usually the C drive. For simplicity, this chapter will 
assume that your A drive receives the WATERS 

· diskettes, and your hard drive is the C drive. 

Before installing WATERS, be sure that your computer 
meets the system requirements discussed above. 

TIP: · tf you .. hove.· trouble iOading WATERS, refer to 
. . . Chapter xi for 'od~ol oos-retafed i~toOotion . . . hints .« < • • . . . 

·. ~····~.--.---:;.;'- : .. . ,_ .... " .• -....... :"! '• •••·••·.. ••• •• .. -.-.--- .... . ' • .• 

Follow the steps below to install WATERS, the Screen 
Editor, WMS, and the GIS data on an individual PC or 
a local area network. 

Step 1: Insert the WATERS program disk into your A drive. 

Step Z: Type A: Press I Return I. 

Step 3: Type Install A: C: and press I Return I. 

· Step 4: 

Step 5: 

The INSTALL program will create a directory on your 
C drive named WATERS, and will then copy the 
WATERS program and temporary database files to 
the WATERS directory. 

WATERS will ask: Would you like to install the 
WATERS Mapping System now? (Y /N). To install 
WMS, type Y, press I Return I, and go to step 5. If 
you do not want to install WMS, type J:::!, press 
I Return I, and go to step 7. 

When the system finishes installing the WMS program 
files, it will prompt you to enter fhe diskette 
containing the GIS data. Eject the WATERS program 
diskette and insert the GIS data diskette into the A 
drive and press I Return I. 

WATERS User Guide 7 



Step 6: 

Step 7: 

StepB: 

Step 9: 

Step 10: 

Chapter Ill. Installation and Start-Up 

After the data has been installed, the system 
displays a screen of information describing the 
remaining steps you must take to make WMS 
operational. You must: 

• Install the Maplnfo runtime module according to 
the instructions enclosed with the software 

• Edit your autoexec.bat file to include the location 
of the runtime module in your path 

• Edit your autoexec.bat file to set the CGIPATH to 
that of the runtime module. 

For more details, see Chapter IX. 

Remove the diskette from your A drive. 

WATERS is now available on your C drive. You may 
start WATERS and experiment with the test data, or 
delete the test data and enter your own data. 

If you are installing WATERS on a LAN, please 
continue through step 11 to assign WATERS to the 
network directory you choose. 

To ensure WATERS can run proper1y on your system, 
edit your config.sys file to set Files= value to 83. 
See Chapter XI for more details. 

Copy WATERS into the appropriate network 
directory. 

Delete WATERS from your local hard drive. 

8 WA TEAS User Guide 



Step 11: 

Starting 
WATERS 

Step 1: 

Chapter Ill. Installation and Startup 

Type Del * .mem at the DOS prompt for the network 
drive to signal the network server that the data is 
not on your hard drive. 
',.. "("> " - .,... '"-' , y~ , , .. )" ' • .. • 

TIPi'. FofµN use~ the· netwprlc· directory your lAN 
jt~t,~:. ·~odrriniSrra1oi ChQoSeS Will (epk:K:e· the'c: \HATERS 
.~:.·/ ~; /,prop-lpL ~: ·". : ... :~ ',;. . , .. ,. . . 

Network administrators should inform users of how to 
access WATERS on their particular network. 

Follow these steps each time you want to start 
WATERS: 

Type .c.;.. (or specify the appropriate network drive)· 
and press I Return I, 

Step 2: Type CD\ WATERS and press I Return I. 

Step 3: 

Step 4: 

You are now in the WATERS directory, as indicated 
by the c: \WATERS prompt on your screen. 

You will only need to perform this step the first time 
you start WATERS. It will prompt you to Please 
enter the full path to the data. Press 
I Return I if you have followed the installation 
directions in this chapter and are not accessing 
WATERS on a network. This signals to the computer 
that the data path is c: \WATERS. However, if you 
are a PC user and you did not follow the instructions 
described above. or you are using WATERS on a 
LAN, the data may be in a directory other than 
c: \WATERS. Type the path to that directory and 
press I Return I_ 

Type WATERS at the c :WATERS prompt and press 
I Return I. 

You have just instructed your computer to load 
WATERS. While it is loading, a start-up screen with 
the name of the program will appear on your 
monitor. 

WATERS User Guide 9 



Chapter Ill. Installation and Start-Up 

Once WATERS is completely loaded, you will see the 
Permits screen shown below in Exhibit Ill - 1. The 
system displays the first well in the database (sorted 
by the 11Well ID"). If there is no data in the 
database, the screen will display a blank record. 

Exhibit Ill • 1: Pennits Screen 

Application Nwnber 
Perini t Number 

867585 Well Identifier UT02337 
UT89756'7W Type of Well Prmtd Converted 

Type of Well Permit 
No. of Wells/Permit 

Individual Class 2 
1 Type 2H Liquid Hydroc 

1967/04/05 Technical Review 1967/01/15 
1967/07/26 Public Notice 1967/06/18 
1967/08/25 Public Hearing 1967/07/17 
1969/07 /07 Permit Term 5 Years 
Permit Tra Expiration 1993/03/17 

Date Plugged/Abandoned I Date Pemit Denied 
Date Withdrawn 

I I 
I I Com111ercial Facility N 

Deleting Test 
Data 

Step 1: 

Step2: 

p D 

ll:>n-UIC File Menu 

The test database that is automatically installed with 
WATERS will be very useful to you while you are 
learning how to use the system. However, when you 
are ready to begin entering your own data into 
WATERS, you must delete the test data. Follow these 
steps: 

At the DOS prompt, type ,C.;. and then press 
I Return I_ 

Type Cd\ WATERS and press I Return I. 

10 WATERS User Guide 



Step 3: 

Chapter Ill. Installation and Startup 

On your screen, c: \WATERS will appear. This is 
called the c: \WATERS prompt. It indicates that you 
are in the WATERS directory. 

Type Utilitv Delete and press I Return 

This command executes a program to delete all 
existing data in all of the WATERS databases. Before 
doing so, it will prompt you to confirm that you wish 
to delete the records. 

Type :! to continue. 

TIP: If you use ffie Utility Delete. program aft~ _you 
~ , .... · begin addirlQ yo\Jrown data~ yo\iwill .detete·yoor 

l ' . . . 
. .. own data .. '"' '",.. 

Step 4: Type C:\WATERS and press I Return 1. You have 
now returned to the c: \WATERS prompt. 

You are now ready to enter your own data into 
WATERS. 

TIP: Sack up yoor WATERs. dotci regUtarty .. : · Whiie the 
. ' . ' programs can,t>e' refnstoned from disks: your. data 

': could be·lost in·fhe event of a hard disk faUUre ct 
. , . . . . ' ." . ·'<I ·,.,.' , . ' 

. , some :other , problem. , S~ .~apter "V,I for 
• v , • i'ls1ruciions on:h<>w. t9 use the 't?ac~p f\JncitOn. . . 

WATERS User Guide 11 



Folders 

Chapter IV. The Basics of WATERS 

IV. The Basics of WATERS 

WATERS contains two modules of data: one for ~c 

wells and one for non-UIC wells. The data are 
separated into folders according to UIC progrc · y. 

activities. There are six folders for UIC wells and one 
for non-UIC wells. The UIC folders are: Permits, 
Inventory, Inspection, Mechanical Integrity Tests 
(MIT), Compliance/Enforcement, and Operation: 
The non-UIC folder contains both permits and 
inventory information. A folder contains a screer :x 
a series of screens with data about individual wells. 
Each folder is identified by tabs or labels that 
appear near the top of the screen. All tabs are 
visible regardless of which folder you are currently 
accessing. 

To access the UIC data, type .U. To access non-UIC 
data, type li. Once in the UIC dataset, select a 
folder by typing the highlighted letter of its title (i.e., 
f for Permits). When you access the non-UIC data, 
you automatically access its one folder. Just as you 
can flip through sheets of paper to see the contents 
of a paper folder, you can flip through screens to 
view the contents of the computer folder. WATERS' 
visual effects appear to slide the screens into place. 

Each well has only one Permits and Inventory 
record, each containing multiple pages of data 
elements. In contrast, the other folders have only 
one page of data elements but may contain 
multiple records for each well. Use the number keys 
or I Page Up I and I P~ge Down I to move between 
pages; they will appear to move horizontally across 
the screen. 

12 WA TEAS User Guide 



Menus 

Chapter IV. The Basics of WATERS 

Four menus contain WATERS functions for operating 
the system. Their names are always visible in the 
upper left comer of the screen. They are as follows: 

Menu 

File Menu 

Edit Menu 

Query Menu 

Help Menu 

Functions 

Systems administration, 
information and 
control functions. 
Database modification 
functions . 
. Query and reporting 
functions. 
Help text file. 

The functions in these menus are described in more 
detail in Chapter VI. 

WATERS User Guide 13 



Sample Screen 

Menu 

Chapter IV. The Basics of WATERS 

The exhibit below highlights the key components of 
WATERS' user interface. 

Exhibit IV-1: Sample Screen 

Active lokler (MIT) 

WellO 

Operaacr~---=Op: DUIOH OIL PllOPEITIES 
U-+--Firsl MIT rac:ord name llell Idtlltiher llr02l~l 

1'90/12/12 Del• lecord t.\ldlted 
llIT lhtoeued 

DID a..dw1ck/007 
19'7 /0i/l~ Pu9ld 

I I 

1990/0l/14 Peued 

1990/03/1~ PA19ld 
Cllrrct llecord lev1w 

1989101/23 
'l\lb111;/P.:ker 

lorMI 

First page ~ rac:ord 
(aclivat 

~ 

m":1.---'--TC(al nll'lter ~ 
...._~~~~~~~~~~~~~~~~~~~~ ~ MITrec:onlslor 

wel 
'JjtU:\~{ loll-UIC Slfltcb to llec:IWD1cal Integrity Ta1t1 tor th11 lie 

·Navigation 

Massage box 

You navigate in WATERS by using your keyboard. 
Generally, pressing and releasing a key performs an 
action once. Holding the key repeats an action. 
For instance, if you hold the I Page Down I key, WATERS 
will continue to flip through multiple pages of a 
folder until you stop pressing I Page Down I: 

14 WATERS User Guide 
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Letter and Number 
Keys 

A through Z 

Number Keys 

, I to I 9 

I - I 
Q 

Function Keys 

Page up I 

Chapter IV. The Basics of WATERS 

You can use the number and letter keys to navigate 
through WATERS. 

Press the highlighted letter of any title, menu item, or 
folder name to access that item. For example, press 
f. to move to the.Permits folder or press! to move to 
the Inventory folder. Pressing f will bring up the Edit 
menu. Letter keys will work from any point in the 
system except when you are editing a record 
constructing a query, or building a custom report. 
You must finish editing the record, or complete the 
query or custom report before you are able to use 
the letter keys to navigate the system. If you wish, 
you can use the I §Pe I key to cancel your 
editing, querying, or custom report session. 

You may also use the number keys to navigate 
through WATERS. 

Flips through multiple pages of a folder. 

Moves to the previous record in the current folder. 

Moves to the next record in the current folder. 

You can use a number of function keys to navigate 
your way through WATERS. 

Flips through pages of a folder in reverse order to 
show the previous page or screen. For example, the 
Inventory folder has six pages. If you are on the fifth 
page, press I Page up I to get to the fourth page. 
You can also use the number keys to move between 
pages. 

If you are on the first page in the folder, I Page Up 
will move to the last page of the previous folder. For 
example, if you are on page one in the Inventory 
folder, I Page Up I will move you to the last page in 
the Permits folder. You cannot use I Page Op I if you 
are on the first page in the Permits folder. 
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Flips through multiple pages of a folder to show the 
next page or screen. For example, the Inventor>' 
folder has six pages. If you are on the second page, 
press I Page Down I to get to the third page. You can 
also use the number keys move between pages. 

If you are on the last page in the folder, I Page Down I 
will move you to the first page of the next folder. For 
example: If you are on page six in the Inventory 
folder, I Page Down I will move you to page one in the 
Inspections folder. 

Returns you to the main menu. This function key is 
useful if you decide not to select a 'menu option. For 
example when you access a menu, you can use 
I EScape I to return to the main menu if you decide 
not to select any of the menu options. Removes a 
pop-up window when a cancel option is available. 

Selects a title or item when it is highlighted. Moves 
the cursor to the next field you can enter or edit 
during data emry, find, and custom report mode. 
You can also use the tab key to move to the next 
field. 

Selects a title or item when it is highlighted (same as 
return). 

Moves the cursor to the next field you can enter or 
edit during data entry, find, and custom report 
mode. You can also use the tab key to move to the 
next field. 

Accesses on-line help. 

Accesses the link menu. 

Switches folders when constructing a link and when 
searching across folders. 

Marks fields for inclusion in custom reports. 

Displays criteria for link. 
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Highlights the appropriate menu or folder. Press 
I Return I to select that item. 

Moves you vertically through menu options and 
fields in the edit, query, and custom report mode. 
Press I Return I to select that item. 

There are also a series of control-character 
commands that can also help you make your way 
through WATERS. 

Displays a dialog box when you have entered, 
edited, or copied a record. This box allows you to 
save, cancel, or edit the record. 

Displays a dialog box when you have entered 
search criteria. This box allows you to submit, clear, 
or edit the query criteria. 

You may also use I Control I - I End I. 

Displays a dialog box when you have entered, 
edited, or copied a record. This box allows you to 
save, cancel, or edit the record. 

Displays a dialog box when you have entered 
search criteria. This box allows you to submit, clear, 
or edit the query criteria. You may also use 
I Control I _ W. 
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V. WATERS Folders 

This chapter describes all the folders in WATERS, 
giving data elements, validity checks, and other 
details and requirements for both UIC and non-UIC 
wells. For UIC data, the chapter also describes how 
the folders are related. 

The six UIC folders in the WATERS system are Inter­
related because most UIC wells that you track will 
have data in all folders. WATERS enables you to 
relate the events in a folder (e.g., the inspections 
records in the Inspection folder) to the wells to which 
they apply. Each well must have one (and only 
one) record in the Permits and Inventory folders. 
These folders hold much of the basic information 
about the well that seldom changes, such as permit 
conditions, location, construction, and ownership. 
This data is stored on multiple pages or screens, 
which you can access using the I Page Op 1, 
I Page Down I , or number keys. 

In contrast, the Inspection, MIT, Compliance/ 
Enforcement and Operations folders may contain 
multiple records for each well. This is because these 
folders track recurring events for a well, such as 
inspections, MITs, violations, and enforcement 
actions. Each of these records is only one page in 
length. 

TIP: You· can odd pages to ,_~Of~ irf~iriSfleP.~:: 
. MIT, Complionce/Enf~ment:'.ilo,d.; aper~ 
· ro1defs b :Usi· , · ihe ser8en'£d1tor •. ,, ~ s l ·~, • n· . y ng,,, . ,,. , .. , •' , . '~~~~~~ . 
· · eqit~.is. .~c~:i:l QjQPf~ .. ~llJ::'':~:.~~i>:·~ ... ~ 

Each time an event occurs for a specific well, you 
can add a record to the system. A well's unique ID 
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links these events to the basic well information in the 
Permits and Inventory folders. 

WATERS' user-friendly interface enables you to 
quickly and easily move between folders for a 
specific well. You can also move through a specific 
folder to view information about multiple events or 
multiple wells. When you switch to a different folder, 
you will see the data for the same well you were 
viewing in the previous folder. For the folders with 
the potential for multiple well records, you can also 
move between well records in the folders to see 
data on individual events related to that well. While 
in any folder, you can move to the next well by 

using the I + I and I - I keys .. 

When you move from folder to folder, you might try 
to view a folder that contains no information for the 
current well. If this happens, WATERS will display a 
blank record in that folder with the Well ID in the top 
right comer. You can instruct WATERS to change to 
another folder by pressing the appropriate letter in 
its title, or you can view a different well in the current 

folder by pressing the I + I and I - I keys (or 
using the Query menu options to select a well). 

TIP: To print an·jrjdivJd~I po,ge of·ony.folder •. ~ploy 
. . ' .. thaf :page of ~ folder on the sci~-and press . . ,, · 1 J>.rtat Satttt I · ~: ·· ~ · ·· :' '- :· . . , .: 

The sections that follow describe each folder in 
detail. 

There are two single record folders in WATERS -the 
Permits folder and the Inventory folder. 
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The Permits folder consists of four pages of data 
elements. The first page contains well identification 
and permit application data elements. The second 
page contains data elements on the well' s allowed 
operating parameters and permit conditions. The 
third page contains financial responsibility data, and 
the fourth page contains free-form comments. 
WATERS automatically enters this folder upon start­
up. Type f to get to the Permits folder if you are 
working in any of the other UICfolders. 

Since permits are the starting point of UIC tracking 
and monitoring activities, the Permits folder has 
several requirements and features to ensure that 
WATERS adequately supports program functions. 
These requirements are: 

1. Each well MUST have a Permits record. WATERS 
will not allow you to enter information into the 
other folders until you have entered Permits data 
for that well. 

2. Every well MUST have a unique Well ID. This is the 
key WATERS uses to track each well and to link 
each event (i.e., violations, enforcement actions, 
inspections) to a specific well. 

3. For rule authorized wells, the only open fields on 
the first page are "Well Identifier", "Type", "Date 
Plugged", and "Commercial Facility". 

4. For Wells requiring a permit, you can enter data 
into any of the open fields on page one. You 
cannot save the well record unless you enter the 
following fields: 

• "Rule Authorized" 

• "Permits Well ID" 

5. WATERS automatically calculates the field "No. of 
Wells/Permit". It determines how many wells 
have the same permit number and displays that 
value. When you add additional wells under that 
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area permit, WATERS automatically updates this 
field. 

6. The 11Well ID" and the 110perator Organization" 
are displayed at the top of the screen regardless 
of the current folder. 

WATERS verifies data when you attempt to save a 
record. You can enter invalid data; however, 
WATERS will not allow you to save the record. When 
you save a new or updated record, some of the 
data fields are automatically checked for accuracy. 
An error message appears if there is a discrepancy 
in the data. When it detects an error, WATERS 
automatically places the cursor at the appropriate · 
field so you can re-enter the data without having to 
search for the appropriate field. Error checks for the 
Permits folder ensure that: 

• Required fields are entered (i.e., 11 Rule 
Authorized", "Permits Well ID", 11Well Class" and 
11Type"). 

• The 11Permits Well ID" and 11Application Number" 
are unique. 

• Salt Water Disposal wells are not "Rule 
Authorized." 

• 
11 Expiration Date" is later than "Date Permit 
Effective". 

• 
11Date plugged/abandoned" is earlier than the 
data entry date. 

• "Well Class" and 11Well Type" match. 

• 
11 Latitude" is between -90° 00' 00" and 90° 00' 
00". 

• "Longitude" is between -180° 00' 00 and 180° 00' 
00". 

• The minutes value for 11 latitude" and "longitude" 
is less than 60'. 
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• The seconds value for "latitude" and "longitude" 
is less than 60". 

~._pates~~~~ ol _Yicx/~~/Doy. If yo\J 
. · ..;'-1ry ~e in a dtrtentnt fonn. WAlBS 
· · •er<Jlliiff.·;~,. -.. . ' ·"·-" : · 

When you finish entering the well's Permits data, you 
must save the record in one of the following-three 
ways: 

• Press I Page Op I until you reach the first Permits 
screen. Then press I Page Op I once more. 

• Press I Page Down I until you· reach the last Permits 
screen. Press, I Page Down I once more. 

• Use the I Control I _ w or I Control I _ 
I Ena I key sequences. 

After you perform one of these actions, a dialog box 
appears on the screen asking you if you wish to save 
your changes. Select Yes_to save the new 
information. Select No to delete the information you 
just added. To return to the screen to make 
changes, select Cancel. Choose the option by 
highlighting it and pressing I Return I. 

WATERS automatically creates a record in the 
Inventory folder when you add a new well to the 
Permits folder. You should enter the Inventory data 
after entering the Permits data for a new well. Some. 
data elements entered in the Permits folder are 
automatically displayed on screens in the Inventory 
folder for reference purposes. These fields are: 
"Well ID", "Permits Number", "Rule Authorized", and 
"Latitude" and "Longitude" of the well. However, 
these fields can only be edited in the Permits folder. 
Any changes are automatically reflected in the 
Inventory folder. 
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The Inventory folder contains five types of data 
elements displayed on six pages. They are well 
identification, owner and operator data, 
construction data, geological data, and 
hydrogeological data. To access the Inventory 
folder, type !. 

You cannot copy a welt's record from the Inventory 
folder without copying its Permits record because 
the Permits and inventory information are 
interrelated. When you try to use the copy function 
in the Inventory folder, WATERS will automatically 
move you to the P~rmits folder, where you can use 
the copy function for both folders. 

When you are entering or editing data in the 
Inventory folder, WATERS performs error checks on 
the data as it did for Permits. The error checks 
ensure that the data in the Inventory folder are 
accurate and meet the following requirements: 

• The 11Date Well Drilled" cannot be earlier than the 
"Date Permits Issued". 

• "Date Well Drilled" must be later than the "Date 
Permit Effective". 

• The 11Date of First Injection" cannot be earlier 
than the "Date Drilled". 

• The 11Date of First Injection" cannot be earlier 
than the "Date Permit Effective". 

• The 11Date of First Injection" cannot be earlier 
than the "Date Permit Issued". 

• "Packer Depth" cannot exceed "Total Depth". 

• "Packer Depth" cannot exceed "Plug Back Total 
Depth". 

• · "Plug Back Total Depth" cannot exceed Total 
Depth". 

• "Surface Casing Diameter" must be greater than 
the ulntermediate Casing Diameter". 

WATERS User Guide 23 



Geological 
Information 

Hydrological 
Information 

Chapter V. WATERS Folders 

• "Surface Casing Diameter" must be greater than 
the Long String Casing Diameter". 

• "Surfoc ::. Casing Diameter" must be greater than 
the "l.. ~g Diameter". 

• "Intermediate Casing Diameter" must be greater 
than the "Long String Casing Diameter". 

• "Intermediate Casing Diameter" must be greater 
than the "Tubing Diameter". 

• "Long String Casing Diameter" must be greater 
than the "Tubing Diameter". 

• "Surface Casing Depth" must be greater than. 
the "Total Depth". 

• "Intermediate Casing Depth" must be less than 
"Total Depth". 

• 
11Long String Casing/Liner Depth" must be less 
than "Total Depth". 

• 
11Tubing Depth" must be less the'"' "Total Depth". 

• "Injection Interval" must be wit· :;i the "Injection 
Zone". 

• "Confining Zone" must be above "Injection 
Interval". 

• "Total Thickness" cannot be less than zero. 

• "Thickness of USDW" cannot be less than zero. 

• "Intervening Thickness" cannot be less than zero. 
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The Inspection, MIT, Compliance/Enforcement, and 
Operations folders contain only one core page of 
data elements; however, each may contain 
multiple records for a specific well, each 
represented by a single page or screen. For 
example, wells inspected more than once will have 
multiple records in the Inspections folder. To add a 
record to these folders; a Permits record must exist 
for the well. 

Two options are available to determine if there are 
multiple records for a specific well. First, a number 
tab will appear along the right margin of the record 
when there are multiple records for a well. Press 
I Page Op I or I Page Down I to view these separate 
records. Second, use the List option in the Query 
menu to browse through all of the existing records. If 
you see the same well identifier listed more than 
once, then several records exist for that well. To 

view a record, highlight it using [!] and [j] and 
press I Return I. 

While there are similarities across these folders, they 
also have unique features: type of data, method of 
access, and error checks. The next sections 
describe these features. 

The Inspection folder contains the name of the 
inspector, the date and type of inspection, and the 
outcome of the inspection. 

The error checks ensure that: 

• Required fields are entered (i.e., "Well ID" and 
the "Date of Inspection"). 

• The combination of "Well ID" and "Date of 
Inspection" is unique. 
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MIT The MIT folder contains the name of the inspector, a 
record of the well's past tests, current test results, 
and remedial actions from the current test. WATERS 
automatically calculates the 11 Date/Result of Last 
MIT'' and 11Last Corrective Action Date" fields in the 
MIT folder. These fields cannot be edited. 

Compliance/ 
Enforcement 

WATERS revie,vs MIT records with the same 11Well 
Identifier" and retrieves the date and result of the 
most recent MIT test and the most recent 11Date of 
Remedial Action" from the MIT folder. WATERS also 
automatically generates the "Multiple Enforcement 
Actions" field, alerting permit writers to recalcitrant 
violators. A Y in this field indicates that more than 
one enforcement action was needed to bring this 
well back into compliance. 

Error checks ensure that: 

• Required fie!-·: are entered (i.e., 11 Date Record 
Updated" ar.:J the 11Well Identifier"). 

• The combination of the 11Date Record Updated" 
and "Well Identifier" is unique. 

• A well passes both the fluid migration and the 
leak test to have a complete two part test. 

The Compliance/Enforcement folder contains data 
elements for violations, penalties, and enforcement 
actions. In this folder, the pop-up list for the 11Type of 
Violation" field has violations marked with an asterisk 
(*). This indicates that these violations are potentially 
instances of Significant Non-Compliance (SNCs). 

• Dates cannot be entered into both the 11 Date 
Final" and 11 Date Withdrawn" fields. 

• Required fields are entered: 

1. "Type of Violation Occurred/Verified" 

2. 11 Date Violation Occurred/Verified" 

3. "Type of Enforcement Action" 
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4. "Date Enforcement Action Taken" 

5. "Well Identifier" 

• A combination of the following fields is unique: 

1. "Date Violation Occurred/Verified" 

2. "Date Enforcement Action Taken" 

3. "Well Identifier" 

The Operations folder contains operating status 
data, and fluid volume, rate, and pressure 
information. Error checks ensure that: 

• Required fields are entered (i.e., i•well Identifier", 
"Date Status Effective", and the 
"Owner/Operator Number" fields). 

• The combination of the "Well Identifier" and the 
"Date Status Effective" is unique. 

WATERS tracks a variety of non-UIC wells, including: 

• Underground storage tanks 

• Production wells 

• Monitoring wells 

• Drinking water wells 

• RCRA facilities 

• · Superfund sites 

• Manufacturing plants 

• Industrial complexes. 

Non-UIC data is stored in a single folder. It has three 
pages containing a limited amount of data for well 
identification, location, owner/operator information, 
and general comments. To access the non-UIC 

data, type .t::!. or use ~ and ~to highlight the 
option and press I Return 1. 
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Many of the features of the non-UIC folder are 
identical to those of the UIC folders. Like the Permits 
and Inventory folders, the non-UIC folder has 
multiple pages but only one record per well. You 
use the same keys to navigate the folder, and have 
the :.:.me menu options (see the next chapter). 
WATERS also performs error checks in the non-UIC 
folder. 

Error checks ensure that: 

• Required fields are entered (i.e., "Well Identifier", 
"Latitude", and "Longitude" fields). 

• The "Well Identifier" is unique. 

• 
11Latitude" must be between -90° 00'00'' and 90° 
00'00." 

• "Longitude" must be between -180° 00'00'' and 
180° 00'00." 

• The minutes value for "latitude" and for 
11longitude" must be less than 60'. 

• The seconds value for "latitude" and for 
"longitude" must be less than 60". 
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VI. Menus 

This section describes the four menus WATERS uses to 
administer, maintain and navigate the system: File, 
Edit, Query and Help. You can select a menu by 
typing the capitalized/highlighted letter in its title: f 
for File, f. for Edit, Q. for Query, and H for Help. 

You·can also select menu options t;>y.using t~e [!] 
and l1J to highlight your choice and pressing 
I ketum I 

The File menu allows you to customize portions of 
WATERS' user interface and provides you with quick 
access to information about the data and the 
system. 

To access this menu, type f. You cannot access the 
File Menu by typing .E if you are editing a record, 
constructing a query, building a custom report, or 
viewing another menu. Exhibit Vl-1 shows WATERS 
with the File menu open. 
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Exhibit VI • 1: File Menu 

------------------ .... ---------------ur Turn Effects Off 
set Verify Off 
l'ort Configuration 
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clock . Number 
r 

Quit 1 Pennit 
sf Permit 

t'll .. 1!111111!!""!111!11~.loate 
Date Pennit Issued 
Date Penni~ Effective 
Date Per~.: Modified 
Type of . ., cmi t Mod 

Date Plugged/Abandoned 

N 

147853 
UT1234A 
Area 

3 

Commercial Facility N 

Well Jdeot if ier 
Type of Well Pnntd 
Class 
Type 

Technical Review 
Public Not ice 
Public Hearing 
Permit Term 
Expiration 

Date Permit Denied 
Date Withdrawn 

0'!'02353 
Converted 
2 
2R Enhanced Reco 

I I 
I I 
I I 

10 Years 
I I 

I I 
I I 

#Wid.~faf) llOn-UIC Display Current WATERS Version Reference Number 

The File menu contains the following options: 

• Version 

• Tally 

• Backup 

• Tum Effects Off/On 

• Set Verify Off /On 

• Port Configuration 

• Clock 

• Quit 

- ..... 

To select a menu option, use[!'] and[!] to 
highlight the option you wish to select and then 
press I Return I, or press the highlighted letter of 
the option's title. 

Version 

The following section describes each of these 
options in detail. 

Displays the current version of WATERS and the 
release date. 
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Tally Counts and displays the number of records in each 
folder. The Permits and Inventory folders will have 
the same number of records because an inventory 
record is created automatically each time a new 
well is added to the Permits folder. Since each well 
has only one Permits record, the number of records 

· in the Permits folder is also the number of wells 
tracked in WATERS. 

Tally counts events in the Inspections, MIT, 
Compliance/Enforcement, and Operations folders. 
The tally given for each of these folders represents 
the number of events for all wells. 

TIP: 1l\e taly may include deletedTeeon:ls If you have 

Backup 

Turn Effects Off /On 

Set Verify Off/On 

· not used the U11llTY ·PAC( program since deleting 
WATERS records .. 1he UTILITY PACK program is 
described in O\opter XI. 

Creates a backup copy of your WATERS data. You 
must use a formatted disk to backup data. 

Tums the visual "effects" (flipping pages and sliding 
folders) off and on. The default for this option is on. 
Turning these effects off can increase the speed of 
navigating through the system. The menu option 
changes to reflect the current choice. For example, 
if you have turned off the effects, the menu option 
reads Tum Effects On. If you tum the effects on, the 
menu option reads Tum Effects Off. 

Tums verification on and off. The default for this 
option is on. When verify is turned on, WATERS asks 
you to confirm your choice any time you delete, edit 
or save a record. WATERS will not ask you for 
confirmation if you tum verify off. You can turn 
verification off when you are making similar changes 
to many records and do not wdnt to verify each 
change. The menu option changes to reflect the 
current choice. If you have turned verify off, the 
menu option will read Set Verify On. If you tum verify 
on, the menu option reads Set Verify Off. 
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Selects printer port for printing. The default is LPT 1. 

Displays the current date and time of the internal PC 
clock in· a pop-up window. 

Closes WATERS and returns you to DOS. 

The Edit menu contains all of the options to add, 
modify and delete UIC well data (see Exhibit Vl-2). 

Exhibit VI • 2: Edit Menu 

1'7853 
OT1234A 

Well Identifier OT023S3 
Type of Well Pnntd Converted 

·-

Type of Well P•nnit Ar .. Class 2 
No. of Wells/Permit ) ~ 2R Enhanced Reco 

Applicaeion Dae• 
Dace Pennie Issued 
Date Pel"lllit Effective 
Date Pel"lllit Modified 
Type of Pennit Mod 

Technie•l Review 
Public Notice 
Public Hearing 
Permit Term 
Expiration 

I I 
I I 
I I 

10 Ye•ra 
I I 

Date Plugged/Ab&ndooed 
CC1111Mrcial Facility N 

eeord 

Det.e Permit Denied 
O.t• Withdrawn 

To access this menu, type f. You cannot access the 
Edit menu by typing f if you are editing a record, 
constructing a query, viewing another menu, or 
building a custom report. The Edit menu contains 
the following options: 

• Add 

• Copy 

• Edit 

• Delete 

• Table 
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To select a menu option, use[!] and [tJ to 
highlight the option you want and then press 
I ketum I. You can also press the highlighted letter 
of its title. 

The following section describes each of these 
options in detail. 

Add Create a blank record into which you can enter 
new well data. When you select add, the fields you 
can enter data into tum red. To enter owner, 

operator or guarantor data. press [EiJ while 
positioned on these fields to access the Owner. 
Operator. or Guarantor table, and select the · 
appropriate name. See Appendix A, Section V for 
detailed instructions on adding records. 

TIP: ·To odd or edit o name In 1he Owner. Operotor or 
· · Guarantor tables .. access the Table option which 

·: is discussed below. . 

Copy Copies information from a current record to a new 
record. This feature enables you to avoid retyping 
data if a well with similar characteristics is already in 
the database. WATERS displays the fields that can 
be edited in red. After you copy a record, you must 
change information in some of the fields to ensure 
that the record is unique. For instance, in the Permits 
folder, all wells must have a unique well ID. In the 
MIT folder there must be a unique well ID and date 
updated combination. See Appendix A, Section VI 
for detailed instructions on copying records. 

TIP: You cannot copy o wel record In the lnventOfy 
folder withotit copying the weB's Permits folder 
record because the Permits ond inventory 
ilformafion ore interrelated. When you trt to use 
the copy funcflon in fhe lnventay.fdder.,~AlERs 
wl automoticoly move you bode to the Pennits 
folder, where you can use the copy functton for 
both folders. 
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Enables you to change the information in the fields 
of an existing record. Use the navigation keys to 
move to the desired field; however, you must use 
the Table function to edit owner, operator, and 
guarantor fields. See Appendix A, Section VII for 
detailed instructions on editing records. 

Deletes a record. When issued from the Permits and 
Inventory folders, this command deletes all the 
records for that well from every folder. When issued 
from the Inspection, MIT, Compliance/Enforcement, 
and Operations folders, it deletes only the specified 
record. The option prompts you to verify your 
choice before deleting. Press X to delete. Press N 0r 
I EScape I to abort the deletion. WATERS will not 
ask you to confirm your choice if you have selected 
the Set Verify Off option in the File Menu. See 
Appendix A, Section VIII for detailed instructions 
about using the delete command. 

Enables you to edit, add, list, and delete 
owner/operator and guarantor information from a 
lookup table. This information can be edited only by 
using the Table function. 

The Query menu contains functions that allow you to 
search for wells by characteristics you specify, and 
produce a variety of reports based on all wells or a 
subset. 

You can access this menu in two ways: 

• Use the ~and lB to highlight the Query 
menu, and press I Return I. 

• Type .Q. You cannot access Query menu by 
typing .G if you are editing a record, constructing 
a query, building a custom report, or viewing 
another menu. 

Exhibit Vl-3 shows WATERS with the Query menu 
open. 

34 WA TEAS User Guide 



Chapter VI Menus 

Exhibit VI • 3: Query Menu 

rile Bdit _:~:;:\ •elp 

l;!!!!!~!i!i!!!i!!!I~ ~i~dFind 
Explain Criteria 

0 Rule A ----------------
8 Save Query 

Appl ic Lold Query 

§ Permit Delete Query 
. Type o Load Custom Report 

No. of Delete Custom Report § Applic ;~~~;~;---------

~ iili !i"'J:a.:~lil-~.~.~~.-.-~Iii~-.-•• 
8 Date Plugged/Abandoned 

Comnercial Facility 

f)':#i¢;/:f •on-UIC List Records 

N 

3 
2135W Well Identifier 

'l'ype of We 11 Prmtd 
Class 
'l'ype 

Tec:hn1c:al Review 
Public: Notice 
Public: Hearing 
Pemit Term 
Expiration 

Date Permit Denied 
Date Withdrawn 

DT02353 
Converted 
2 
2R Enhanced Reco 

I I 
I I 
I I 

10 Years 
I I 

The Query menu contains the following options: 

• List 

• Find 

• Clear Find 

• Explain Criteria 

• Save Query 

• Load Query 

• Delete Query 

• Load Custom ·Report 

• Delete Custom Report 

• Reports 

• Well Schematic 

• Geographic Information System (GIS) 
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There are two ways to select a menu option: 

• Use [!] and [1] to highlight the option you wish 
to select and then press I Return I . 

• Press the highlighted letter of the menu option's 
Pie 

'-.: You cannot~-~ oplonS ltd ore not °"'*°*, fot:emmPe. ~ ca~t select the 
Delete~ optb't unless~ haVe ihttaVed a 

,: q.Jelly. Options you canoot seje "ct'- ShrxJed ., 
lhe ~.and do not have~ .. ..-~tit1ed., nwnnes : .. :-. :· . .--= .~;,: 

The following section describes each of these 
options in detail. 

List Displays a table of key information about all active 
well recorc: ·· the c·.:: :ve folder. You can scroll up 

and down the list using [!] and [1] or by typing a 
part of the "Well ID". If you want to see one 
particular well' s records, scroll down to its line and 
press I Return I. If you want to see several wells' 
records, press I Control 1- I Enter I when you 
highlight a record. This will place a check-mark next 
to the ID number of that well. When you press 

· I Return I you will see the record of the first well 
you check-marked. Your database will be limited to 
the check-marked records until you select the Clear 
Find option explained below. 

T'' .-:. r able on the following page outlines what 
information the List option will show when you are in 
each of the folders: 
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Folder 
Permits· 

Inventory 

Inspection 

MIT 

Compliance/ 
Enforcement 

Operations 

Fields Displayed 
"Well ID" 
"Permits Number" 
"Owner /Operator" 
"Well ID" 
"Permits Number" 
"Owner /Operator" 
"Well ID" 
"Date of Inspection" 
"Well ID" 
"Date MIT Record Updated" 
"Well ID" 
"Date Violation Occurred" 
"Type of Violation" 
"Date of Enforcement Action" 
"Type of Enforcement Action" 
"Well ID" 
"Date Operating Status Effective" 

1'91: 1he UU function dis~ 1he ()pe(ator if one exists. 
If the record· does not contain open:rtor . . 

infonnation .. It lsts the OWner. WAlERS·disploys 
Op: or Ow: before the · 0rgonizatiOn ·name to 
hdc:ote which is shown. · · 

See Appendix A, Section F for detailed instructions 
on using the list function. 

Find Locates records in the current folder based on 
criteria you specify. You can search in all WATERS 
fields in which you have entered data and across 
multiple folders to locate information. For. more 
detailed explanations on the types of queries you 
can perform, see Chapter VII. 
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Save Query 

Load Query 

Chapter VI. Menus 

Clears the current query. Use the Clear Find option 
to regain access to the complete dataset. This 
option is only available when a query is active. 
When the Clear Find option is not available, the 
menu option will be shaded and no letter of its title 
highlighted. When the Clear Find option appears in 

· the menu, it indicates that you are not working with 
the entire database. · 

TIPr Wherl c:i quer\f-is octive. 1he word .. find• appears 
in the toP- rtght comer of you screen. · 

Lists the selection criteria of an active query. When 
you select this option, a window appears at the top 
of the screen listing your current selection criteria. 

This option is only available when a query is active. 
When the Explain Criteria option is not available, the 
menu option will be shaded and no letter is 
highlighted. 

Saves an active query. This option is beneficial 
when you want to retain your search criteria. When 
you choose the Save Query option, a dialog box 
appears in the middle of the screen asking you to 
name the query. The name you choose will also be 
used in the Load and Delete Query options 
explained below. As in the Clear Find and Explain 
Criteria options, you can only save a query after you 
have performed a search with the Find option. 

Retrieves and executes a previously saved query. 
This option lists all saved queries in alphabetical 
order. You can scan the list of query names and 
select one to retrieve, which automatically begins a 
search. Under the Load Query option. WATERS 
replicates the search steps it does with the Find 
option. 
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Deletes a saved query. This option lists all saved 
queries in alphabetical order. You can scan the list 
of query names and select one to delete. WATERS 
asks if you to confirm that you want to delete the 
query. If you select Yes, your query will be deleted 
and cannot be retrieved. WATERS will not ask you to 
confirm your choice if you have selected the Set 
Verify Off option in the File Menu. 

Retrieves one of the customized reports previously 
saved when using the Report menu option. This 
option lists all saved reports in alphabetical order. 
You can scan the list of report names and select 
one to load. Loading the report automatically runs 
the report so you do not have to recreate the 
criteria. 

Deletes a saved customized report. This option lists 
all saved reports in alphabetical order. You can 
scan the list of report names and select one to 
retrieve. WATERS asks you to confirm the deletion. If 
you select Yes, the report is deleted and cannot be 
retrieved. WATERS will not ask you to confirm your 
choice if you have selected the Set Verify Off option 
in the File Menu. 

Produces a variety of reports, including EPA's 
Federal reporting forms, a variety of management 
reports for local program use, and the ability to 
design custom (ad hoc} reports. More detailed 
information on reports can be found in Chapter VIII 
and in Appendix A, Sections Mand N. 

Produces a diagram of the well on your screen. The 
diagram displays the well's specific measurements, 
dimensions and hydrogeological data based on the 
data in its Permits and Inventory folders. You cannot 
edit the well schematic when it is displayed on your 
screen. To change a well schematic, you must edit 
the data in the Permits and Inventory folders. 

General Class II construction is used for all well 
schematics. The well schematic displays up to three 
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USDWs, two confining zones, and two injection 
intervals. The specific elements displayed in the well 
schematic are: 

• 
11Well Owner/Operator Name" 

• "Well Identifier" 

• "Surface elevation" 

• "Range of the USDW" 

• 
11TDS of the USDW" 

• "Range of the confining zone" 

• "Lithology of the confining zone" 

• "Surface casing diameter" (inches), "depth" 
(feet) : 'Id "grade" 

• "Inter-·· ~diate casing diameter" (inches), 
"depth" (feet), and "grade" 

• "Long string casing/liner diameter" (inches), 
"depth" (feet) and "grade" 

• "Tubing diameter (inches), "depth" (feet) and 
"grade" 

• "Packer depth" 

• "Total depth" 

• . "Injection interval" (feet) 

TIPs WATERS ctsploys'the ~or if one e>dsts. ond 
·· -puts ·an ~0p:• before 1he name: otherwise._ H 

displays the Owner and :places -an 'Ow~' 
preceding the Owner's~; 

You do not need all of these data elements to 
produce a well schematic. If a well does not have 
data in certain fields, then this information will not be 
displayed in the schematic. 
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The well schematic in WATERS Version 2.0 has several 
limitations: 

• "Plug Back Total Depth" is not displayed. 

• No cementing information is displayed. 

• WATERS will produce well schematics for all well 
classes. but the diagrams wm follow the standard 
Class II construction. 

For detailed instructions on producing and printing a 
well schematic. see Appendix A. Section L. 

Accesses the optional WATERS Mapping System 
(WMS). If this option is shaded, you.do not have· 
access to WMS. See Chapter IX for more details. 

The Help menu provides a summary of key WATERS 
commands and procedures. 

You can access this menu in two ways: 

1. Use the ~ and IB to highlight the Help menu, 
and press I Return I. 

2. Type H. You cannot type .ti to access the help 
menu when editing a record, constructing a 
query, building a custom report, or viewing 
another menu. 

· Exhibit Vl-4 shows WATERS with the Help menu open. 
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Exhibit Vl-4: The Help Menu 

•dit Que ~- . ~ 
KIT c:ompl/Enf Oper4tions 

------uT02353 

Application Date 
Date Permit I•aued 
Date Permit Effective 
Dote Permit Hodif ied 
'!Ype of Penni t Hod 

N 

147853 Well Identifier 
UT1234A Type of Well Pnntd 
Area Class 

3 Type 

I I 

Technical Review 
Public Notice 
Public Hearing 
Permit Term 
Expiration 

Date Plugged/Abandoned 
Commercial Facility N 

Date Permit Denied 
Date Withdrawn 

UT02353 
Converted 
2 
2R Enhanced Reeo 

I I 
I I 
I I 

10 Years 
I I 

I I 
I I 

)@1*iC:':\f' •on-UIC Display Window with All Navigation Keys 

Navigation 

How Do I. .. 

This menu has two options: Navigation and How do 
I.. .. There are two ways to select each option. 

• 

• 

Use [!]and [j] to highlight the option you wish 
to select and then press I Return I . 

Press the highlighted letter of the menu option's 
title. 

The following section describes both of these 
options. 

Provide-5 a brief synopsis of key navigation 
comr :rids, key sequences and function keys. 
Chm :::r IV describes all WATERS commands in 
greater detail. 

Provides an overview of WATERS functions and 
features for easy reference. 
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VII. Query 

WATERS' query capabilities are a powerful data 
analysis tool that you can use to make more 
informed decisions and increase your UIC program's 
effectiveness. Queries enable you to locate and 
select specific records based on criteria you specify. 
They identify relationships within your database that 
ordinarily may not have been noticed, or without 
WATERS would have been too time-consuming to 
demonstrate. 

You can perform a query using several different 
Query menu options described in Chapter VI and 
VIII. You can use the Find option, the New/modify 
query in the Reports option, or create a custom 
report through the Reports option. 

Regardless of the path you take to start a query, its 
basic procedures are identical. You use the same 
format to search individual fields. Each path offers 
the same two types of queries: single-folder and 
cross-folder. After you approve the query criteria, 
WATERS displays the same messages. This chapter 
.will explain the search formats, single-folder and 
cross-folder queries. and WATERS' query messages. 

WATERS allows you to do specialized queries for 
character, logical, and date fields. 

• To find all of the records in which that field is not 
empty, type an asterisk (*) . 

• To find all records in which ·a field is empty, type a 
minus sign (-). 

• To search for an exact value (e.g., number, 
date), enter the value in the field. A pop-up 
window appears that asks you to enter the 
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ending value in the range. Leave the field blank; 
just press I Return I . 

• To search for a range of values (e.g., numbers, 
d9tes), enter the beginning value of the range. 
When the pop-up window asks, enter the ending 
value. 

• To find all of the records in which a particular 
date field is empty, type 1901 /01 /01 into the field. 

• To find all of the records in which that date field 
contains a value, type 1900/01 /01 for the 
beginning of the range and 2099/12/31 for the 
end of the range. 

In single-folder queries, you search within one or 
more fields within the same folder. For example, you 
could search in the operations folder for all wells 
whose observed "Maximum Injection Pressure" is 
1500 psig. For detailed instructions on how to 
perform a single-folder query, see Appendix A, 
Section G. 

Cross-folder queries allow you to search in multiple 
fields across multiple folders. For example, you could 
search for all wells whose observed "Maximum 
Injection Pressure" is 1500 psig, but whose "Allowed 
Injection Pressure" is 1400 psig. The observed 
pressure is a data element in the Operations folder, 
while the allowed pressure is an element in the 
Permits folder. 

Performing a cross-folder query involves several 
steps. Enter your search criteria in one folder, just as 
you would for single-folder queries. To move to 
another folder, use either the I Page Down I key or . 

rill. Pressing I Page Down I will move you page by 

page through each folder. Pressing [ill will 
produce a pop-up window that lists each folder 
name. To select a folder, type the highlighted letter 

of the title or use your [!] and [iJ and press 
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I Return I. Then enter your search criteria in that 
folder. When you have finished entering the criteria, 
press I control I- W to begin the search. 

Ordinary cross-folder queries search for data in 
multiple folders, but do not compare values of the 
data elements. However, very often you will need 
to search for a dependent relationship between two 
elements. In the example given eartier, the search 
criteria was wells whose observed injection pressure 
was 1500 psig, while their allowed "Injection 
Pressure" was 1400 psig. But it is more valuable to 
know which wells exceed their allowed injection 
pressure. You can perform the latter query through 
linking the values of the allowed "Injection Pressure" 
in the Permits folder to the observed "Maximum 
Injection Pressure" in the Operations folder. 

The restrictions for linking are listed below: 

• A field can be linked to only one other field. 

• One of these fields must be in the Permits or 
Inventory folders. 

• The fields must be in separate folders. 

• Only fields of the same type can be linked 
together: character to character, date to date, 
and.numeric to numeric. 

To link two fields, move to the first field in the Permits 

or Inventory folder. To select that field, press [Eg]_ 
WATERS places an asterisk next to the field you 
selected to signify it is part of a link. A pop-up 
window will appear, listing oil folders, with the active 
folder shaded. Select the second field's folder, 
which will become active. 

Move to the second field and press [§] again. A 
new pop-up window lists a series of operators. The 
message box on the bottom of the screen will 
explain what each operator signifies. Scroll through 
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the list using [!]and l1J to select one operator. If 
you were to perform the example given earlier, you 
would select < (less than). A second window will 
display your link criteria. 

If you are linking two dates or two numbers, you will 
have the option to modify your link .further. You can 
either add or subtract days/numbers from the 
second field you have linked. Building on the earlier 
example, you may want to examine only the wells 
whose injection pressure exceeded the allowed by 
at least 100 psig. In this case, you would add 100 to 
the observed 11 Maximu!TI Injection Pressure". If you. 
do not want to modify the link, press I Return · I 
without entering a value. WATERS will move you 
back to the Permits or Inventory folder where you 
began your search. 

You can perform as many links in a single query as 
you would like. You can also delete a link without 

de.leting your query. Press [£[] to see a list of the 
links. Select the one you want to delete, and press 
I Return I. WATERS will ask you to confirm your 
choice. 

Once you have finished entering all your query 
criteria, press I Control 1- W. A pop-up window 

. gives you the option to begin, clear, or edit your 
search. If you type S.. WATERS starts to search for 
matches to your criteria. While it does so, it displays 
two new pop-up windows. The first, at the top of the 
screen, lists the search criteria. The second, in the 
middle of the screen, gives you an estimate of how 
much of the search WATERS has completed. See 
Exhibit VII for an example. 
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Exhibit Yll·1 

Pile Sdit $~;Rj~f~ Jlelp ••••c====-•:scDWATERS Stat fit Systemzs::z:ca:•••:a======= ~ -.....__-1 

OOmpl/Enf Operations 

Operating Status is not empty 

0 
Wall Identifier 

0 ga~~.~~~t~atus 
O Status Ettac:tive 
0 
0 
g Minimwn 
0 Average 
O Max1mW11 

Injection 
(ps Pass l I 1 

lf ::~~::ing ~~1n2 
·:·:·:·:': <Esc> to cancel 

n Rate 
/day) 

Annulus Pressure 
(psigJ 

0 Annual Volume of 

0
0 Injected Fluid 

Fluid '!Ype 
barrels 

The window shows the following: 

• The pass the search is on 

• The total number of passes the search requires 

• The number of records processed so far 

• The total number of records 

• The number of matches found so far. 

When WATERS completes a search, the first window 
still displays the search criteria. The second window 
displays the total number of matches found. After 
you press any key, ·wATERS will display the word 
FIND in a box at the top right comer of your screen. 

WATERS reacts in different ways depending the 
option you used to perform your query: 

• If you use the Find option under the Query menu, 
WATERS moves to the first record in the database 
that satisfies the criteria you entered. 

• If you use the Load Custom Report option, 
WATERS will ask where you want the report sent 
to and execute your choice. 
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• If you create a custom report or use the 
New/modify Query option through the Reports 
option, WATERS will either print or display the 
report. When you exit a custom report, WATERS 
will ask if you want to save the report. 

TIP: When ygu·cn JI~ wiib any querv.. nmember 
to use·fhe ~·~ 0pta\~1he ~ 

. menu.Olhent4e; ar.y ~~~.ans·o 
QUelYWI ot:tf octon ht.~ yliu:dald For 
examp~. If youselect.N:~.q.\~ the ody 
~:, .csted w11 be ~ .coes· rne~'SJ to 'tOtJr 
~ .ofterta. tf. you-pMorm .o .. subsequeot 
search: WAlERS ·~ ~ Sreoactl ttwough .the 
octtveS1~t of dcito. · .. · · · · · · · 
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WATERS' reporting function is a unique feature of the 
system. WATERS can produce facsimiles of EPA 7520 
quarterly reports. It also provide~ an extensive set of 
management reports designed for use at the 
program implementation level. You can create 
custom reports to meet specific needs. To produce 
reports, type Q. to access the Query menu and R to 
select the Reports option. 

Once you have done so, a dialog box with five 
windows will appear on your screen (see Exhibit Vll-1 
below). 

Exhibit Vlll-1: Reports Menu 

Pile Jklit :ij#19.~j •elp ===•••=c=•••sWATERS State Systttm=•••cc=====•••••••••s 

Reports 

-Scla.chll.• a.port•----

current List 
All Welli; 
New/aodify Query 

la~• Por: 

~~~h 
Year 
1st ~arter 
~~~ u:~:~ 
4th uarter 

Each window represents a step you will take to 
generate a given report. To select any choice in a 
window, type the highlighted letter of the title, or use 
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your l!J and l1J to highlight the item and press 
I Return I. 

The first window, Select a Report Type, lists the 
following six report types: 

• Schedule Reports 

• Status Reports 

• Enforcement Reports 

• Well by Well Reports 

• Misc. Reports 

• 7 520 Reports 

The second window is dynamic. It lists specific 
reports associated with the report type highlighted 
in the first window. The next three windows almost 
always lists the well range, time frame, and report 
destination. A few reports superimpose a different 
window over the time frame. 

This chapter discusses the standard windows for well 
range, time frame, and report destination. It also 
describes ir :..ietail the report types, the individual 
reports associated with each type, and any 
changes to the time frame window for particular 
reports. 

~- The ·.~ennntons ror·:we11 j~., ~-'.~-~·~·-~~·PM 
- . repott are the some:-c·~~ -ore not 

applcable ·for ol:feP<Jds. .: ff«:~ •. 0 'Wei 
. '· . schemoHc re~Wil f'C)t.hc;IVe 'a·~ iri:ime .. 

When you select a report, 1he options thOt en 
not available are shaded. · 

WATERS has a series of reporting features which will 
help you build reports to meet specific needs. 
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A well range limits the report to a subset of well 
records. The four range choices are located in the 
window titled Range: Current Well, Current List, All 
Wells, and New/modify Query. 

If you select Current Well, your report is limited to the 
well record that was on your screen before you 
accessed the Reports option. Current List restricts 
the report to the wells that meet your query criteria 
{if you processed a query before accessing the 
Reports option). All Wells produces a report on the 
entire database. New/modify query allows you to 
either enter search criteria to limit your report, or 
modify your current search criteria Without exiting 
the Reports option. 

The procedures for using New/modify query are 
identical to querying through the Find option. The 
only difference occurs when you press any key to 
remove the window displaying the number of 
matches. Instead of returning to the first record 
meeting the query criteria, WATERS generates the 
report you selected. 

The Schedule For window contains the time frames: 
Today (current date), Month, Year, and the First 
through Fourth Quarters of the Fiscal Year you 
specify. 

Y cu have the choice of routing these reports to a 
printer, sending them to a print file, or viewing them 
on the screen (the HP Laser Jet, Print File, and Screen 
options respectively). 

When you send a report to the HP Laser Jet printer, 
WATERS will print the entire report. You cannot print 
a portion of a report. The printer must be in HP-PCL 
mode. You cannot print reports using postscript. 

Sending a report to a Print File allows you to print it 
at a later time. The first time you select Print File in 
any session, WATERS will ask you to name the print 
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file. If you select Print Fite more than once in a 
session, WATERS will append the report to that file. 

When you view reports on the screen, they may be 
wider than your screen. You can scroll to the left 
and the right by typing .L or&. Type f or~ to move 
across the screen at a slower pace. WATERS 
displays the reports one screen at a time, allowing 
you to view the current screen until you are ready to 
continue or cancel the report. Type 11N" to look at 
the next page. An exit prompt appears at the 
bottom of each screen. 

11PI There is no commond 1t<i Joolc ·~f ~previous 
page if yoo 1YPe li.tO move to 1he next .page. · 

There are several report types available through 
WATERS. 

~ ~epajs that ~itide ·~~ ~. ond. Operat0r 
: ftelds 1st the ~Of if one itJdstS; otherwise they 

.... 1st the awrier.' Some·Tepom~e.wh1Ch.1s 
· · :asted by ~ting. d».i:~~1 ~~QW~~ :'before ~e 

orgarization name .. 

There are two types of Schedule Reports: Inspections 
Schedule and MIT Schedule. You may choose a 
schedule for inspections due or overdue today, in 
the next month, or in the first through fourth quarter. 
Each are described below. 

Lists all routine periodic inspections that are due 
within a specified time period. Periodic inspections 
are due one year after the last inspection. If the 
date of the next inspection is before the current 
date, the inspection is overdue. The report is sorted 
by "County". 

This report displays the following fields: 

• "County" 

• "Permit Well ID" 
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• "Operator Name" 

• "Well Type" 

This report also provides historical information about 
the last inspection. It includes: 

• date the next inspection is due 

• date of the last inspection (periodic or other) 

• type of last inspection 

• if there was a violation found at the last 
inspection 

• type of enforcement action tak.en, if any 

• if there is an unresolved (i.e., open) violation in 
the Compliance/Enforcement folder. 

Unresolved violations are defined as violations which 
have nothing entered in the "Date Returned to 
Compliance" field. 

Lists all MIT inspections due within the time frame you 
specify. The frequency of MIT inspections is specified 
in the Permits folder for each well. Mils can be 
conducted annually, semi-annually, or every five 
years. If no frequency is specified, WATERS assumes 
that the frequency is annual for this report. The 
report is sorted by "Field Name" (found in the 

· Inventory folder). 

This report displays the following fields and 
information: 

• "Permit Well ID" 

• "Operator name" 

• "Field Name" 

• Date of the last MIT 

• Result of the last MIT 

• "Type of Construction" 

WATERS User Guide 53 



Status Reports 

Injection Status 

Chapter VIII. Reports 

• "Operating Status" 

• "Date of next MIT " 

• If the MIT is overdue 

• If the well has an unresolved ("open") violation 

An unresolved violation indicates that the well has 
an unresolved, failed MIT, or an unresolved 
compliance/enforcement action. The most recent 
MIT record and all the Compliance/Enforcement 
records are checked for this report. 

WATERS generates a variety of status reports 
including Injection Status, Folder Summary, and 
Operating Status Sumrr -·ry. 

Displays the most recent injection information for 
each well. The information is sorted by "Permit Well 
ID". The report displays the following fields: 

• "Permit Well ID" 

• "Owner/Operator Name" 

• "Field Name" 

• "Well Type" 

• "Fluid Type" 

• "Annual Volume" 

• "Average Pressure" 

• "Maximum Pressure" 

• "Maximum Permitted Pressure" 

• "Date Operations Record Updated" 

All fields are from the Operations folder except the 
"Permit Well ID" and "Maximum Permitted Pressure" 
, which are from the Permits folder. 
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Summarizes key data for the active folder. The 
active folder appears in parentheses next to the 
menu option. For example, when selected from the 
Permits database, this report option appears as: 
"Folder Summary (Permit)." If you select Current Well 
as the range, a Folder summary of Inspection, MIT, 

· Compliance/Enforcement, and Operations would 
print all the records for that well in the folder. If you 
select All° Wells, only the most recent records of these 
folders are selected. 

The table on the following page shows what 
information each Folder Summary Report contains. 
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Folder Name Fields Displayed 

Permits "Permit Well ID" 
"Permits Action" (e.g., Issued, 
Rule, Modified), 
"Date of Action" (unless the 
well is rule authorized, in which 
case the field contains 
"Authorized") 

Inventory "Inventory Well ID" 
"Rule Authorized" 
"Owner/Operator Name" 
.. Well Description" (of the 
location) 

Inspections "Inspections Well ID" 
"Inspector Name" 
"Date of Inspection" 
"Type of Inspection" 
"Violation Discovered?" 

MIT "MIT Well ID" 
"Inspector Name" 
"Date of MIT Test" 
"MIT Witnessed?" 
"Result of MIT Test" 

Compliance­
Enforcement 

Operations 

56 

"Compliance/Enforcement 
Well ID" 
"SNC?" 
"Date of Last Compliance 
Review" 
"Result of Last Compliance 
Review" 
"Operations Well ID" 
"Date Operations Record 
Updated" 
"Operating Status" 
"Date Status Effective" 
"Annual Volume of Injected 
Fluid" 
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Produces a summary of wells by type and operating 
status. 

There are five enforcement reports that WATERS can 
generate, including the Violation and Enforcement 
Report, the Administrative Order List, the Judicial 
Order List, the Operator Violation Summary, and 
Pressure Exceedence Report. 

Prints the most recent violation and enforcement 
information for each well. The report is sorted by 
"Field Name". 

The report displays the following fields: 

• "Permit Well ID" 

• "Operator Name" 

• "Field Name" 

• "Date of Violation" 

• "Violation Type" 

• "SNC?" 

• "Date of Enforcement Action" 

• "Type of Enforcement Action" 

• "Penalty Assessed" (in dollars} 

TIP: In repons. that print the type of Violation field 
(e.g., Enforcement Status .. keo of Review), an 
asteristc (•J appearing ofter the type of violation 
lf.l~t~ ~potential SMC. 

Lists all administrative orders (AOs) issued within the 
time period you specify. It also includes violations 
resolved as the result of a previously issued AO. For 
the reporting year, you can select one quarter or 
the whole year. The default for the reporting year is 
the current year. 

The report includes the following fields: 
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• 
11Permit Well ID" 

• 
110wner/Operator Name" 

• 
11Well Type" 

• 
11Date Enforcement Action Taken" 

• 
11Date Violation Occurred/Verified". 

• 
11 Date Returned to Compliance" 

• 
11Docket Number" (first 14 characters) 

• 
11 Penalty Assessed" (in dollars)· 

• 
11Penalty Collected" (in dollars) · 

• "SNC?" 

• 
11 ln Wellhead Protection Area?" (WHP) 

• 
11Type of AO" 

Lists all judicial orders issued within the time period 
you specify. It also includes violations resolved as 
the result of a previously issued judicial order. For the 
reporting year, you can select one quarter or the 
whole year. The default for the reporting year is the 
current year. 

The report includes the following fields: 

• 
11 Permit Well ID" 

• 
110wner/Operator Name" 

• 
11Well Type" 

• 
11 Date Enforcement Action Taken" 

• 
11Date Violation Occurred/Verified" 

• 
11Date Returned to Compliance" 

• 
11Docket Number" (first 14 characters) 

• 
11Penalty Assessed" (in dollars) 

• 
11 Penalty Collected" (in dollars) 

• 
11SNC?" 
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• "In Wellhead Protection Area?" (WHP) 

• "Type of AO" 

Lists violators and the percentage of violations that 
are SNCs for the past 365 days. Violators are 
defined as those operators/owners responsible for 
one or more violation(s) in the past year, not 
including monitoring and reporting violations. The 
report is sorted alphabetically by 
"Owner/Operator", and displays the: 

• "Owner/Operator Name" 

• total number of wells for which Owner/Operator 
is responsible 

• number of these wells in violation 

• percentage of the these violations that are SNCs 

Computes all wells whose most recent recorded 
pressure (found in the Operations folder) exceeds 
the allowed pressure (found in the Permits folder). 
The report displays the: 

• "Operations Well ID" 

• "Allowed Injection Pressure" 

• "Observed Injection Pressure" 

• "Date Operations Record Updated" 

Each Well by Well Report compiles information on 
one well. You can select All Wells for a range, but 
this simply produces multiple reports on individual 
wells. 

Prints records from the specified WATERS folders. 
While in the UIC database, you can print any of the 
six UIC folders, or choose the entire set of folders. 
You must be in the non-UIC module to print non-UIC 
records. You can only send the Folder Print Report to 
the HP LaserJet. The Print File and Screen options 
are not available for this report. 
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Displays a limited amount of data for an individual 
v .. ell, including Permit information and the most 
recent Inspection, MIT and 
Compliance/Enforcement information. 

Produces well-specific compliance/enforcement 
information. WATERS finds all the violations within the 
period you specified. The c:~fault period is two 
years. This report includes he: 

• "Owner/Operator Name" 

• "Permit Number" 

• "Date v;olat: _ -, Occurred" 

• "Type of Violation" 

• "Date Enforcement Action Taken" 

Sumrr ·:]rizes permit data for a particular well. The 
majonry of the data shown comes from page one of 
the Permits folder. This report also includes the: 

• "Owner/Operator Name" 

• 
110perating Status" 

• "Well Construction" 

• "l. ·ude" and "Longitude" 

• "Date First Injected" 

• "Date Drilled" 

Lists all UIC and/or non-UIC wells in the current well's 
Area of Review (AOR). You can specify the radius of 
the well's AOR. The default is two miles. You can 
also choose the type of wells to include in the AOR 
(i.e., UIC, non-UIC or both). 

WATERS compares the "Latitude" and "Longitude" 
for each well in the system with the "Latitude" and 
"Longitude" of the curr· .t well, and determines 
which wells fall within tha specified radius. WATERS 
also determines if any well within the radius may be 
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defective. A well is potentially defective if it meets 
any of the following conditions: 

• the existing surface, intermediate, and long string 
casings are not cemented 

• it has an unresolved compliance/enforcement 
violation (not including a monitoring or reporting 
violation) 

• the surface casing depth is less than the base 
depth of USDW 

• it failed its most recent MIT test (either part) and 
has not yet been subject to a remedial action 

• its depth penetrates the confining zone of the 
current well 

Prints the well schematics for all wells you select in 
the given range. You can print a well schematic 
when you view it on the screen; however, this report 
is a fast way to print a batch of wells schematics. 

WATERS can also generate some custom reports as 
well as some reports on non-UIC wells. 

Allows you to create your own report (i.e., ad hoc 
report). A custom report can contain almost any 
combinations of WATERS data elements and can be 
combined with queries to provide greater flexibility. 
You can save the report format and the search 
criteria used to create the report. 

TIP: The od:-; flek:ls you cannot use in o custom report 
ere those fields that WATERS ccdc:uloted. The four 
cok:oklted fields are: 

• "Number of wets/ permit". 

• •oate of last MIT' 

• •Result of fast Mir' 

• "Lost Corrective Action" 
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Once you have selected OK in the Reports window, 
WATERS will open the active folder and display in 
red all fields available for your report. The 
commands needed to navigate this screen are the 
same as those used during editing and querying. 
While you are selecting the fields, you can also enter 

·any search criteria the report may require. To select 

a field, press lfiJ. To move to another folder, select 

lfIJ. 
The fields you select and the order in which you 
select them determines the report's format'. The 
field names become the report's column headings. 
The first column is always the Well ID. When you 
finish viewing or printing the report, WATERS will give 
you the option to save it. 

For a detailed example of creating a custom report, 
see Appendix A, Section P. 

Provides a brief overview of Permits and Inventory 
data for non-UIC wells. You can choose this report 
when you are in the UIC database. However, if you 
are not in the non-UIC database, you cannot set the 
report range to the Current Well or Current List. nor 
can you issue or modify a query. The Non-UIC report 
displays the following fields: 

~ 11 Non-UIC Well ID" 

• "Latitude" and "Longitude" 

• "Facility Type 

• "Finds Number" 

• "Permit Number" 

• "Permit Type" 

• "Date Permit Issued" 

• "Date Permit Effective" 

• "Legal C ::Jntact" 
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WATERS also generates all of the reports associated 
with EPA Form 7 520. 

Prints all of the forms (EPA 7520-1, 2A, 2B, 3, 4, and 5). 

Generates Parts I - VII of the Permits Review and 
Issuance report (EPA 7520-1). Parts VIII and IX must 
be completed manuaUy. WATERS is not capable of 
making the subjective decisions on the AOR_section 
of the EPA 7520-1 section, so the program leaves 
section VIII for you to complete. The AOR (Well by 
Well) report can help you analyze the AOR and 
complete the form. 

WATERS prints forms EPA 7520-2A and 28. 

Prints EPA Form 7520-3. WATERS has more options for 
MIT tests than the EPA 7520 forms approved by the 
Office of Management and Budget (OMB). 
However, the tests in WATERS are in the same order 
as the tests listed on the OMB approved forms to 
eliminate any confusion. 

Prints EPA Form 7520-4. This report contains a list of 
all SNCs that have not been addressed by an 
enforcement action for 90 days or more. The wells 
remain on the exceptions list until they have 
returned to compliance. Wells will still appear on the 
Exceptions List for the quarter in which they return to 
compliance; the report will also show the date the 

·well returned to compliance. When the report 
shows "Noncomplianf' instead of displaying the date 
a well returned to compliance, the well has not 
returned to compliance as of the ending date of the 
quarter you selected. 

Prints a blank copy of EPA Form 7520-5: Grant 
Utilization. 

TIP: 75'10 reports may not be di'ected to the screen. 
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• Use the mouse to highlight the option and press 
I Return I. 

• Type the first capitalized letter of its title. 

The following sections describes each WMS menu in 
detail. 

The File menu contains basic information about 
WMS, geographical features, and printing functions. 
The File menu contains the following options: 

• Version 

• Layers 

• Print 

• Quit 

These options are described below. 

Displays the current version and date of WMS. To 
remove the message from your screen, press any 
key. 

Allows you to select the attributes or layers you want 
to display on the map. The default setup includes 
layers for cities, rivers, highways, and boundaries for 
water bodies, counties, states, regions, the U.S., and 
hydrologic boundaries. 

Use this option to tum layers on and off. Active 
layers have unique symbols displayed in the left 
column of the menu and the first letter in the titles 
are capitalized. When you tum a layer off, its symbol 
will not appear. 

TIP: UIC and non-Ute welts ore otwoys plotted. You 
cannot deactivate them with the layers option. 

Press I Escape I when you complete your layers 
selection. WMS will automatically redraw the map. 
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IX. WATERS Mapping System 

The WATERS Mapping System (WMS) is an·optional 
component of WATERS developed using Maplnfo 
software. WMS displays maps of the geographic 
areas surrounding the wells tracked in WATERS. You 
can modify and print these maps to fit your program 
needs. WMS is a powerful analytical tool because 
you can use it to explore the spatial relationships of 
wells that meet conditions you specify through 
WATERS. As a result, you can identify trends or issues 
that might not be apparent without a visual display 
that plots the location of wells. In addition, WMS has 
two supporting utilities that let you customize it to 
meet your needs. 

This section discusses the system requirements for the 
GIS module and the necessary installation routines. 

WMS has the same basic system requirements as 
WATERS. In addition to the system requirements 
identified in Chapter Ill, the WMS requires: 

• .:i Maplnfo for DOS runtime module, and 

• a network module for each simultaneous user. 

The WMS program was automatically installed when 
you installed the WATERS program. WATERS users 
also receive a diskette with regional data for map 
layers. WMS data includes cities, rivers, highways, 
and boundaries for water bodies, counties, states, 
regions, the U.S., and hydrologic boundaries. 

For ·.;JMS to be operational, you must also install a 
Maplnfo runtime module. One runtime module and 
one network module can accommodate two 
simultaneous users. In other words, the number of 
network modules needed will depend on how many 
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users will use the WMS simultaneously. For instance, if 
you expect three users to access the WMS 
component at the same time, you will need one 
runtime module and two network modules. If you 
expect four users to access the WMS component at 
the same time, you will need one runtime module 
and three network modules. 

TIP: If you do not haie a rvntme m~. you must 
-ob,t<*l one from EPA or purchase~· and instal 

it before attempting _to run the w~. -

Identify the path for the runtime module in the DOS 
environment variable CGIPATH. For example, if the 
Maplnfo runtime module was installed into a 
directory called c: \WATERS\RT, the following 
statements are required in the AUTOEXEC.BAT file: 

SET CGIPATH=C:\ WATERS\RT 

P ATH=3PA TH3;C:\ WATERS\RT; 

You navigate in WMS using your keyboard and/or a 
mouse. 

Press the capitalized letter of any title, menu item to 
select an option. 

Press a number to select the cursor speed before 

using the ~. ~. [!], and [tJ. Each number 
corresponds to a cursor distance or speed. Low 
numbers move the cursor small distances or at a 
slower speed. High numbers move the cursor larger 
distances. The default if 4. 

There are a variety of function keys that can help 
you navigate through the WMS. 

Cancels an operation or command. Use the 
escape key to return to a previous menu. If you are 
using a mouse, the right mouse button performs the 
same functions. 
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When you access WMS from the Query menu in 
WATERS, all layers are active and bodies of water 
are filled. An active layer may not be plotted if your 
map has no examples of the point, line or boundary. 
For ~nstance, the cities layer includes the 250 largest 
cities in the U.S. The city layer will not be displayed if 
the area you plot is not located near one of these 
cities 

Print Prints the map displayed on your screen. A printed 
map has two components. The map is printed on 
the top half of the page. A legend is printed on the 
lower half of the page. The legend includes a title, 
display layer keys, north arrow, and a scale. 

Quit 

Edit Menu 

When you select the print option, WMS prompts you 
to enter a title. Then press I Return I to send to the 
printer. WMS uses the same port configuration as 
WATERS. To change the port configuration, return to 

WATERS. Press I Escape I to leave the print option 
and return to the original map. 

Closes the WMS and returns to the WATERS folder 
you were on when you selected the GIS option. 
WMS does not ask you to confirm your choice. 

This menu contains options to modify the current 
map display. When you access some of the options, 
the cursor becomes a pair of crosshairs - intersecting 

perpendicular lines. Using the mouse or ~ [B, 

[!], and [jJ you can move the crosshairs to identify 
the location of map items to modify. When 

crosshairs appear on the screen, you can press (£[] 
to display locational data. Latitude and longitude 
(in decimal degrees) will appear in the left corner of 
the screen. 
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The Edit menu contains the following options: 

• Edit 

• Magnify 

• Zoom 

• Pan 

• State View 

• Last View 

• Erase Text 

• Label 

These options are described below in detail. 

Enlarges a portion of the map. When you select the 
Magnify option, the crosshairs intersect at the 
center of the screen. Use them to draw a box 
around the area you want to magnify. To draw this 
box, first move the crosshairs to the first corner of the 
box to be magnified and press I Return I. Then 
select the opposite comer of the box and press 
I Return 1. 

WMS redraws the map so that the selected area fills· 
your screen. The center point of the block becomes 
the center of the new map. If the block is longer in 
one direction than the other, the system will adjust 
the display of the shorter dimension to account for 
the fact that the map· must be square. Therefore, 
the resulting map displayed may contain a larger 
area than that selected by the user. 
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Selects a menu or option when highlighted. 

Selects a point. 

If you are using a mouse, the right mouse button 
performs the same functions as I Return 1. 

Enter Selects a menu or option when highlighted. 

Crosshairs 

Menus 

Selects a location for a map to be drawn. 

If you are using a mouse, the right mouse button 
performs the same functions as I Enter 1. 

Displays locational data when you access the 
Magnify and Pan options in the Edit menu. 

Scrolls through the menus, options, and maps. For 
any movement with arrows, you can also use your 
mouse. 

Marks points to be modified or explored. Crosshairs 
consist of two perpendicular lines that intersect. 
When you select the appropriate options, the 
crosshairs appear on your screen. You move the 

crosshairs with either the mouse or the B IB. 
[!], and [j], until the intersecting point is on the 
feature or area you want to modify or learn more 
about. 

The WMS produces a map of the geographical area 
surrounding a well within a specified radius. You can 
modify and print these maps using the four WMS 
menus: File, Edit, Query, and Help. You access the 
menus and options three ways: 

• Use the ~ and lB to highlight the option, 
and press I Return I 
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• Use the mouse to highlight the option and press 
I Return I. 

• Type the first capitalized letter of its title. 

The following sections describes each WMS menu in 
detail. 

The File menu contains basic information about 
WMS, geographical features, and printing functions. 
The File menu contains the following options: 

• Version 

• Layers 

• Print 

• Quit 

These options are described below. 

Displays the current version and date of WMS. To 
remove the message from your screen, press any 
key. 

Allows you to select the attributes or layers you want 
to display on the map. The default setup includes 
layers for cities, rivers, highways, and boundaries for 
water bodies, counties, states, regions, the U.S., and 
hydrologic boundaries. 

Use this option to turn layers on and off. Active 
layers have unique symbols displayed in the left 
column of the menu and the first letter in the titles 
are capitalized. When you turn a layer off, its symbol 
will not oopecr. 

TIP: UIC and non-UIC wells ore olwoys plotted. You 
cannot deactivate them with the Layers option. 

Press I Escape I when you complete your layers 
selection. WMS will automatically redraw the map. 
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When you access WMS from the Query menu in 
WATERS, all layers are active and bodies of water 
are filled. An active layer may not be plotted if your 
map has no examples of the point, line or boundary. 
For instance, the cities layer includes the 250 largest 
cities in the U.S. The city layer will not be displayed if 
the area you plot is not located near one of these 
cities 

TIP: The water layer hos two active modes. A body 
of water can be ou16ned or filled. 

Print Prints the map displayec '.)n your screen. A printed 
map has two componems. The map is printed on 
the top half of the page. A legend is printed on the 
lower half of the page. The legend includes a title, 
display layer keys, north arrow, and a scale. 

Quit 

Edit Menu 

When you select the print option, WMS prompts you 
to enter a title. Then press I Return I to send to the 
printer. WMS uses the same port configuration as 
WATERS. To change the port configuration, return to 

WATERS. Press I Escape I to leave the print option 
and return to the original map. 

Closes the WMS and returns to ·!ie WATERS folder 
you were on when you selected the GIS option. 
WMS does not ask you to confirm your choice. 

This menu contains options to modify the current 
map display. When you access some of the options, 
the cursor becomes a pair of crosshairs - intersecting 

perpendicular lines. Using the mouse or ~. [B, 

[f], and [f], you can move the crosshairs to identify 
the location of map items to modify. When 

crosshairs appear on the screen, you can press 1£[] 
to display locational data. Latitude and longitude 
(in decimal degrees) will appear in the left corner of 
the screen. 
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Press any key to remove the message. Use the Pan 
option to reposition the map center. Then select the 
State View option again. 

Displays the previous view of a map after you make 
changes using the Magnify, Zoom, Pan, or State 
View options. You cannot display the previous map 
if you turn off a layer. For example, if you turn off the 
County layer using the Layers option, Last View will 
not return to the state map with the County 
boundaries shown. 

TIP: Labels may be erased when using the Lost View 
option to view a larger area. For example, if you 
use the Zoom option to move from a mop of 
IMinois to the mop of the U.S. you cannot see 
Illinois' labels. When you select Last View to 
return to the IQinois mop, labels ore gone. 

Erases all labels and automatically redraws the map 
display. 

Allows you to selectively label any active 
geographical feature. You cannot select features 
you have made inactive with the Layers option 
under the File menu. All active features have white 
titles in the Edit menu. All inactive features are 
displayed in yellow. Since features are dynamic, 
you cannot type the first capital letter to select a 
menu option. 

When you select one of the features, the crosshairs 
appear in the center of the screen. Use the 
crosshairs to select the feature you want to label 
and press I Return I. WMS labels the appropriate 
feature closest to the point you selected. This text is 
in the same color as the feature itself, so you can 

easily identify it on your screen. Press I Escape I to 
cancel the Label option. 

WMS will not write a label in the place you select if: 
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• The feature you want to label is not located on or 
near the point you selected. 

• The area is crowed with text and there is no room 
for additional labels. 

• The point you select places labels too closely 
together. 

Press any key to continue. 

TIP: If labels are removed from view. they will be 
erased and must be replaced. For example. if 
you use the Pan option to create o new map 
that does not show the previous map•s labeled 
features, the labels wil be deleted. 

This menu enables you to choose a new well to view 
in WMS or in WATERS, and to retrieve a variety of 
information and locational data on wells and other 
features on the map. For all of these options, you 
select points or areas on your map using the 
crosshairs. 

When you access the Query menu, you will see the 
following list of the options: 

• Query 

. • Reselect 

• Well Info 

• Distance 

• Lat-Long? 

These options are described below in detail. 
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The Edit menu contains the following options: 

• Edit 

• Magnify 

• Zoom 

• Pan 

• State View 

• Last View 

• Erase Text 

• Label 

These options are described below in detail. 

Enlarges a portion of the map. When you select the 
Magnify option. the crosshairs intersect at the 
center of the screen. Use them to draw a box 
around the area you want to magnify. To draw this 
box. first move the crosshairs to the first corner of the 
box to be magnified and press I Return 1. Then 
select the opposite corner of the box and press 
l Return I, 

WMS redraws the map so that the selected area fills 
your screen. The center point of the block becomes 
the center of the new map. If the block is longer in 
one direction than the other. the system will adjust 
the display of the shorter dimension to account for 
the fact that the map must be square. Therefore. 
the resulting map displayed may contain a larger 
area than that selected by the user. 
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Zoom Changes the scale of the map, while the center 
remains constant. The map's scale denotes how 
much space each inch of your screen symbolizes. 
Therefore, if you change the width your screen 
represents, you can increase or decrease the area 
your map covers. If you increase the width, your 
map covers more miles per inch of your screen (i.e., 
WMS "zooms out"). If you decrease the width, your 
map covers fewer miles per tnch of your screen (i.e., 
WMS "zooms in"). 

When you select this option, a pop-up window at 
the top c • +he screen displays the current map width 
and pror· :~ts you to enter a new width. After you 
press I Return !, WMS redraws the map. 

Pan Changes the center of the map. When you select 
this option, the crosshairs intersect in the center o~ 
the map. Move the crosshairs to select a new 
center and press I Return I. WMS redraws the 
map, centering on the point you selected. The 
scale remains the same. Cancel the Pan option by 

State View 

. I Escape pressing ..._ ______ ..... 

TIP: If you cannot see the labels on your original mop 
after you use the Zoom or Pon option. then these 
labels are deleted. You cannot select the Lost 
V.ew option to recover the lobeb on your original 
map. 

Enlarges the mop on your screen to display the 
entire state. The center of the current map will 
determine which state is drawn. For example, if a 
well is in the Northwest corner of Massachusetts, the 
center of the map could be in a neighboring state. 
Therefore the State View option will draw that 
neighboring state. Use the Pan option to reposition 
the map center, and select the State View option 
again. 

If the map center is within a_body of water, WMS 
prints the message 'No state boundary found'. 
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Allows you to select a new well to view. You may 
either redraw the map with that well as its center, or 
return to WATERS to view that well's records in 
WATERS' folders. Move the intersecting point of the 
crosshairs to the well you wish to select. Press 
I Return I to get the "Well ID" of the new well you 
selected. You are given three choices: GIS, WATERS, 

or cancel. If you choose GIS, the WMS will redraw 
the map using the well you selected as its center. If 
you choose WATERS, you will be returned to WATERS 
positioned on the well record in the folder that was 
active before you accessed the GIS option. 

TIP: You cannot retrieve the previous map with Lost 
View ofter you select a new wel. 

Provides quick access to key data elements stored 
in WATERS without leaving WMS. Use the crosshairs 
to select a well and press I Return I. If there are 
two wells in the point you select, the Well Info option 
will provide a list of the Well IDs found and require 
you to select one. 

A pop-up window appears in the middle of the 
screen. The first column contains command keys to 
navigate the window. The second column contains 
an alphabetical list of field names. The third column 
contains well data for each of the field names. A 
. complete list of field descriptions is in Appendix B. 

Select OK to return to the map. Select Print to 

print the list. Press I Escape I to cancel the Well Info 
option. 
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Calculates the distance between two points. Move 
the intersection of the crosshairs to select the first 
point and press I Return I. Then move the 
crosshairs to the second point and press l........,R_e..,.turn----.1. 
A pop-up window at the top of the screen displays 
the distance in miles. Press any key to remove the 

window. Press I Escape I to remove the crosshairs 
and deactivate this option. 

Dis~.'ays the latitude and longitude coordinates of a 
we!: , :iu select. Move the crosshairs until the 
intersecting point is on the well whose coordinates 
you wish to see, and press I Return I. At the top of 
your screen, a pop-up window displays the. latitude 
and longitude coordinates of the point you 
selected. Press any key to remove the window. 

Press I Escape I to cancel this option. 

The Help menu provides both a legend for your map 
and explanations of WMS's major functions and 
procedures. When you access the Help menu, the 
following options will appear: 

• Legend 

• How Do I ... 

These options are described on the following page. 

Provides a list of WMS symbols and their descrbtions. 
The legend includes symbols for all wells and for all 
active layers. You can activate and deactivate 
these layers with the Layers option under the File 
menu. All active layers and all wells are listed 
regardless of whether or not they are plotted on 
your map. 

When you finish using the legend, either press 

I Escape I or select OK in the top right corner of the 
legend window. 
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Provides an overview of WMS functions and features 
for easy reference. 

When you installed WATERS, you not only installed 
the Screen Editor, but also two utilities for WMS: the 
Layers Editor and the MOSS2MI Converter. The 
Layers Editor allows you to change WMS default 
layers. Through the Layers Editor, you can add and 
remove layers available to WMS users, and change 
the style in which the layers are displayed. The 
MOSS2MI Converter allows you to convert GIS data 
in the MOSS format to the Maplnfo file format. This is 
part of the process of converting other GIS files into 
layers in WMS. 

Both the Layers Editor and the MOSS2MI converter 
are designed for experienced WMS users and LAN 
system administrators. The rest of this chapter will 
briefly explain the major points of the Layers Editor 
and the MOSS2MI Converter. 

When you use WMS, you can activate and 
deactivate the layers. You cannot, however, 
change the default se.tting or alter the styles of the 
layer. However. the Layers Editor, a Maplnfo 
application, allows you to add and remove the 
layers available to WMS users, change the default 
setting of the layers, and alter the default style of the 
layers displayed. 

To start the Layers Editor, return to the c: \WATERS 

prompt and type LAYERS. Once the program is 
loaded, the opening screen of the Layers Editor will 
closely resemble the initial WMS screen, with a 
standard map and four menus in the top line. 
However, the Layers Editor title replaces the WMS 
title, and the Query menu is replaced by the Style 
menu. Most menu options in the Layers Editor are 
identical to the WMS options. The Edit menu, 
however, has additional options and the style menu 
is new. This secti<2n will only discuss these new 
features. 

WATERS User Guide 75 



Edit Menu 

Add Layer 

Remove Layer 

Chapter IX. WATERS Mapping System 

The Layers Editor's Edit menu allows you to modify 
the current map display, just as the WMS menu did. 
However, there are two new options: Add Layer and 
Remove Layer. 

Makes a new layer available to WMS users. When 
you select this option. you have three kinds of layers 
you can chose from: boundaries, lines. and points. 
Boundaries are completely enclosed, larger blocks 
of land or water; (e.g., a lake, q county). Lines 
include highways and rivers. Points can represent 
smaller portions of land such as cities. 

After you select the type of layer to add, the Layers 
Editor presents a list of databases that you navigate 

by using your mouse or ~, ~, [!], and ltJ. 
Select the database for the new layer, and another 
list will display all the fields of that database. Select 
the appropriate field. WMS will access this field to 

plot the layer. Press I Escape I and the Layers 
Editor will automatically redraw the map to include 
the new layer. The Layers Editor will also assign the 
new layer a unique style. Use the Style menu to 
create a new def a ult style for the layer. 

Removes a layer currently available to WMS users. 
When you select this option, a list of all the layers in 
WMS appears. To remove one, highlight it and press 
I Return I. The Layers Editor will automatically 
redraw the map, and the WMS users will no longer 
be able to activate or deactivate that layer. 

TIP: If you wont to retrieve a layer, you will hove to 
use the Add layer option to redefine the 
database and field of the layef'. 

76 WATERS User Guide 



Style Menu 

Display 

Chapter IX. WATERS Mapping System 

The Style menu allows you to change a layer's 
display (activated or not), and the color of its 
symbol and/or label. When you select the Style 
menu option, it displays a list of all the available 
WMS layers. If the layer is currently activated, it is 
capitalized and its symbol is displayed in the right 
column. 

Press I Return I when you have highlighted the 
layer whose style you want to change. You will see 
a new window with three options for each layer: 
Display. Symbol, and Text Color. The current options 
are displayed in a box to the right of these options. 
You select the option by using your mouse or by 

using the [!] and [j] to move the box and pressing 
I Return I. A list of the available choices for that 
option will be displayed in the middle of the screen. 

To navigate this list. use your mouse or [!]and [j] 
to select the HOME, PG UP, PG DN. and END boxes to 
the left of the list. 

Each of the three options are described in detail 
below. 

Changes the current display. Each layer has at least 
two Display options: outlined (OUT), or off. The 
~oundary layers have an additional option: filled 
(FIL). To change the setting in the Display option, 
click on the box until you see the setting you want. 

TIP: If you sefec1 NONE for a boundary's filled symbol. 
you cannot select o filled display (FIL). 
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Changes the symbol for boundaries and points. 
Lines can only be displayed as lines and you cannot 
change the color. Boundaries can have different 
colors and patterns for the outline and filled displays. 
The outline symbol is in the left box, while the filled 
symbol is in the right. Points can have different 
symbols and colors. Page down to the end of the 
list and select NONE if you do not want to specify a 
pattern or color. If you select NONE for a boundary's 
filled symbol, you cannot select a filled display (FIL). 

Changes the color of any labels on the map. If you 
select NONE, and try to label a map, no labels will 
print. 

When you have completed your changes, press 

I Escape I and the Layers Editor will redraw the 
map. When you exit the Layers Editor, the styles you 
have chosen for each layer become the default 
setting of WMS. 

The MOSS2MI Converter is used to convert the MOSS 
data format to the Maplnfo Import File format. The 
MOSS file format is a standard GIS export format. 
Map layers from other GIS systems, such as 
ARC/INFO and ATLAS Pro, can be exported to the 
MOSS ASCII file format and converted for use in the 
WMS with this utility. The general steps to 
accomplish this conversion ore outlined below: 

Create a MOSS file from your preexisting GIS 

• From ARC/INFO™ use the ARCMOSS command 

• From ATLAS Pro™ use the Export to Text 
Command 

Use the converter to translate the MOSS file to the 
Maplnfo Import File Format. 

• For Boundaries the format is a .MBI file 

• For Lines the-format is a .MMI file 
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• For Points the format is a .DBF file 

Use Maplnfo's IMPORT utility to convert the Boundary 
or Line to a WMS map layer. 

• For Boundaries the utility is called BDYIMP .EXE 

• For Lines the utility is called MAP IMP .EXE 

The Maplnfo Import utilities required for step 3 are 
not provided in the WATERS package. States can 
borrow them from EPA Headquarters or can 
purchase them from Maplnfo Corporation, 200 
Broadway. Troy, NY 12180. (800) 627-4968. The 
MapFile Import Utility and Boundary Import Utility are 
packaged together by Maplnfo for a price of 
$495.00. 

If the utilities are borrowed from EPA, they should be 
used and immediately returned. The utilities are 
protected by copyright laws and must be deleted 
from the borrower's machine once translation is 
complete. By deleting your copy, you are allowing 
the legal use of the borrowed software for other 
state agencies. 

The MOSS2MI Utility was installed along with the 
WATERS. Screen Editor. WMS. and LAYERS software. 
If the input file does not exist or the WMS.PER file was 
not found. an error message is displayed and 
operation stops. lt°the output file already exists, you 
have the option to overwrite it. 

The MOSS2Ml.EXE file has the following syntax: 

MOSS2MI <BDYILINEIPNT> <moss_file> 
<output_f ile> [ color ] [ pattern ] 

The first parameter is a keyword-either BDY for 
boundary conversion, LINE for Line conversion, or 
PNT for point conversion. The angle brackets (<>)in 
the syntax line indicate that the parameter is 
required. and the square brackets ([ ]) indicate the 
parameter is optional. The optional color and 
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pattern parameters are used for line conversions 
only. Legal color and pattern parameters are listed 
below. When not provided, the default color is 
YELLOW and the default pattern in SOLID. 

Color Line Type 

BLACK SOLID 
WHITE LONG-DASH 
RED DO TIED 
GREEN DASH-DOT 
BLUE MEDIUM-DASH 
YELLOW DASH-DOT-DOT 
CYAN SHORT-DASH 
PURPLE 
ORANGE 
MAGENTA 
LIGHT-GREEN 
BROWN 
ROYAL-BLUE 
LIGHT-PURPLE 
LIGHT-YELLOW 
PINK 

TIP: Since line segments symbols ore defined during 

80 

· the import process. ft is not po~ible to change 
the color or symbol of a Line layer In fhe Layers 
Editor. However. the color and pattern for 
bounc · .''.')' layers is configured and changed from 
wtthir1 .. :e layers Editor. 
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The table below lists the default layers in WMS. 

Color Layer Description 

Red CITY The 250 largest cities in the 
U.S. 

Blue WATER Lakes and large rivers 
extracted from the USGS river 
reach file 

Cyn HUC HydrC?logic Unit Code 
boundaries defined by the 
major drainage basins 

White STATE 48 contiguous states in the 
U.S. 

Pur12le County County boundaries 
Blue RIVER Rivers from the river reach file 

classified as pollution 
monitored 

Yellow HIWAY U.S. Highways 

• 
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X. WATERS Screen Editor 

WATERS contains all required and suggested data 
elements contained in the UIC Program's Minimum 
Data Set (MDS), as stipulated in Guidance #68. 
However, EPA's Underground Injection Control 
Branch (UICB) recognizes that many primacy and DI 
programs have more extensive data management 
requirements. Consequently, UICB designed the 
WATERS Screen Editor so you can tailor V.ATERS to fit 
your own program's needs. 

With the Screen Editor, you can add new pages to 
existing folders one define addition jato elements 
for WATERS to tracK. You cannot, h: .:ever, add 
new folders or alter core pages - they contain 
informarion from the Minimum Data Set which must 
remain consistent 7:-.r all WI- -~RS users. This chapter 
describes the use c: the W 1' . ::RS Screen Editor. 

WATERS has fifteen core pages which contain 
information from the Minimum Data Set. You 
cannot add new folders or alter core pages. These 
"core" pages and folders must be preserved in 

. order to compile the EPA Form 7520 reports, and 
track all of the MOS. For a list of the core pages, see 
the Page Names table on the following page. 

The core pages which cannot be edited include: 

• pages 1-4 in the Permits folder 

• pages 1-6 in the Inventory folder 

• page 1 in the Inspections folder 

• page 1 in the MIT folder 

• page 1 in the Compliance/Enforcement folder 
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• page 1 in the Operations folder 

• page 1 in the non-UIC folder 

The Screen Editor assigns page names to all pages in 
WATERS. These page names include a reference to 
the folder name and a page number. The Screen 
Editor uses this naming convention when saving new 
pages. Below is a list of core pages and page 
names. The Screen Editor will generate addiflonal 
page names in the sequence in which you create 
them. 

WATERS Page 

Permits, page 1 
Permits, page 2 
Permits, page 3 
Permits, page 4 

Inventory, page 1 
Inventory, page 2 
Inventory, page 3 
Inventory, page 4 
Inventory, page 5 
Inventory, page 6 

Inspections, page 1 

MIT, page 1 

Compliance/ 
Enforcement, page 1 

Operations, page 1 

Non-UIC, page 1 
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Page Name 

PERM_l 
PERM_2 
PERM_3 
PERM_4 

INV_l 
INV_2 
INV_3 
INV_4 
INV_5 
INV_6 

INSP _ 1 

MIT_l 

COMP_l 

OPER_l 

NONUIC_l 
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The Screen Editor can only be loaded and used 
when you are in DOS at the c: \WATERS prompt. 
(You cannot use the Screen Editor to add pages or 
fields while in WATERS, or while other users are 
accessing WATERS on a network.) If you are at the 
c: prompt, type CD/Waters and press I Return I. 
Then type Scrnedit and press I Return 1. 

TIPi The Screen Editor may request that you to enter 
the data path ff 1he Screen Ed"rtor program is not 
stored in the some directocy as WATERS. If you 
folowed the instalation instructiOns in Chapter IJI, 
then the Screen Editor is In the some dWectory as 
WATERS. 

While your system loads the Screen Editor, a screen 
will appear that is almost identical to the WATERS 
start-up screen. The letters "SE" will blink at the 
bottom of the screen which signifies that the Screen 
Editor is loading. 

Once the Screen Editor is loaded, you will see :: 
screen that resembles WATERS' folders. The majority 
of the screen represents a blank page of an 
unnamed folder (the "adding" screen). (This is 
where all of the editing of WATERS screens will take 
place.) At the top left are the menus: File, Edit. 
Fields. and Color. When you select a menu or 
option. at the bottom of the screen will be the menu 
or option's description. Numbers in the top right 
corner correspond to the page and line location of 
your cursor. 

TIP: When you odd a new page f o folders that can 
have multiple records .. a special tab notation lets 
you differentiate between the page you ere on* 
and the porticulor record you ore viewing. See 
Chapter IV for an example. 
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There are four menus in the Screen Editor: File, Edit, 
Fields, and Color. To access these menus, you need 
to move out of the adding screen by pressing the 

I Alt I key and the highlighted letter of the 
menu you wish to access. 

The File menu has several options that allow you to 
retrieve existing pages in WATERS, and either save or 
delete the changes you have made through other 
menus. 

The File menu has five options: 

• Load Page 

• Save Page 

• Save Page As 

• Delete Page 

• Quit 

You can access these options the same way you 
access menu options in WATERS. 

• Use [!] and [!] to highlight the option you wish 
to select and then press I Return I . 

• Press the highlighted letter of the menu option's 
title. 

TIP: You cannot choose menu options that ore not 
applicable. For example, you cannot select the 
Delete Page option unless you have loaded or 
saved a page. Options you cannot select ere 
shaded in the menu. end do not hove a letter 
highlighted in their titles. 

The following section describes each of these 
options in detail. 
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The "Load Page" function retrieves core and adds 
pages from any WATERS folder so you can edit 
existing pages. When you access this option. you 
will see a pop-up list of WATERS pages grouped by 
folder. To select a page. highlight its name by either 

using your [I) and (tJ and press I Return I. Once 
a page is loaded. it looks exactly like it would in 
WATERS. 

TIP: If you load a core page. you con only save color 
changes. For example, if you lood Perm_ 1 and 
1Ty to odd o field. you wl not be able to save the 

.. pog~ as.~ SQI'~ P99~ f>~-J~ ... 
The Save Page option saves updates to pages 
created with the Screen Editor. If the current page 
has a name. you can select the Save Page option. 
A page is named if you loaded an existing page or 
previously saved the page. If the page has a name. 
the Screen Editor displays it in the top right corner of 
the screen. If the page is unnamed. then the Screen 
Editor automatically reroutes you to the Save Page 
As option. which is discussed below. After using the 
Save Page option. the Screen Editor returns you to 
the field you were on when you selected the option. 

The Save Page As option names a new page and 
saves it in a folder .. 

When you select the Save Page As option. the 
Screen Editor asks you to choose a database if you 
have not already done so through other menu 
options (see the Select Database option under the 
Edit menu). A new window then displays the list of 
page names for that database. The left column 
identifies three types of pages: core. used. and· 
available. Used pages are pages that have been 
added to WATERS using the Screen Editor. If you 
select a used page. you will replace that page with 
the one you are trying to save. An available page is 
the next empty page in the database. When the list 
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of page names appears, the next available page is 
highlighted in red. 

You can use this function to save a page in two 
different folders. For example, you may want to add 
the same page of inspection data elements to both 
the MIT and Inspections folder. First make the 
changes or additions in one folder. Save them with 
the Save Page option discussed above. Then use 
the Save Page As option to save it to the second 
folder. 

The Delete Page option deletes the page displayed 
on your screen. You will get a message to confirm 
your choice. When you select this option, the 
Screen Editor will ask you to confirm that you want to 
delete the page. If so, select yes. 

TIP: You cannot detefe"any.cot;E?tpages in WATERS~ 
Core pages coOtain· information ... ffom····the 
Minimum Data Set~·:··.· · ·--.-

Quit The Quit option ends the session with the Screen 
Editor and returns you to the DOS prompt. To start 
WATERS. type w~.TERS and press I Return I . 

Edit Menu 

TIP: After using the Screen ·Editor, WATERS \vill take 
longer to load because the dotobose indexes 
must be rebuilt. · · · ·· · ··. >/ <• ·'· 

.:.;: /:)-~:~::: ~::_:_: < .... ·,. 

The Edit menu contains options that allow you to 
alter, move, erase or clear entire blocks of the 
screen you are creating. You can also add special 
features and characters to the screen 

The Edit menu has five options: 

• Move Area 

• Erase Area 

• Clear Screen 

• Draw Box/Line 
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• Ascii Character 

You can access these options the same way you 
access menu options in WATERS: 

• Us~ [!]and [!] to highlight the option you wish 
to select and then press I Return I . 

• Press the highlighted letter of the menu option's 
title. 

The sections below explain each of the options in 
the Edit menu. 

The Move Area option moves blocks of text on a 
page. There are two stages in repositioning a block 
- determining the parameters of the block to be 
moved, and moving it. Place your cursor in the 
upper left corner of the block you want to draw. 
Then select the Move Area option. A small sample 
block appears on the screen in place of the cursor. 
Change the dimensions of this block by using the 
cursor keys listed in the message box in the lower left 
corner of the screen. Press I Return I when you 
finish re-configuring the block to cover the area you 
want to move. Use the same cursor keys to move 
the block you have just defined to its new position. 
Use the same command keys to place the block 
and press I Return 1. 

The Erase Area option erases whatever block you 
define. (The Erase Area option behaves like the 
Move Area option.} This option is useful when you 
want to delete a portion of a page. Place your 
cursor in the upper left corner of the block you want 
to draw. Then select the Erase Area option. A small 
sample block appears on the screen in place of the 
cursor. Change the dimensions of this block by using 
the cursor keys listed in the message box in the lower 
left corner of the screen. Press I Return I to erase 
the area. 
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The Clear Screen option clears all text on the screen. 

The Draw Box/Line option draws a line or a box in 
the designated space. To draw either a box or a 
line, place your cursor in the left end or corner of the 
line or box you want to draw. Select the Draw 
Box/Line option, and select either a single or double 
line style. A small segment of this line style will 
appear at the left end of the line you want to draw. 
To turn this segment into a line or box, use the cursor 
keys at the bottom of the screen. When you are 
finished drawing, press I Return I. 

The Ascii Character option displays an Ascii 
character on the screen where designated. Ascii 
characters cannot be created using the standard 
keyboard. For example, you could not type a 

check mark (.I') or[!] and [j]. To create an Ascii 
character, move your cursor to the spot where you 
want to place the character. Then select the Ascii 
Character option. which will display all the available 
symbols. Position the cursor on the symbol you want 
and press I Return I to select it and position it on 
the screen. 

The Fields menu allows you to create, modify, or 
revise fields. Fields contain the well-specific 
information for a particular data element. For 
example, "Rule Authorized" is a specific data 
element on page one of the Permits folder. The 
space where you type Y or N is the first field of the 
Permits folder. 

The Fields menu has these options: 

• Select Database 

WATERS User Guide 89 



Select Database 

Chapter X. WATERS Screen Editor 

• Insert Field 

• Create Field 

• Move Field 

• Erase Field 

• Revise Field 

You can access these options the same WCJ¥-¥0U 

access menu options in WATERS: 

• Use [!]and[!] to highlight the option you wish 
to select and then press I Return I . 

• Press the highlighted letter of the menu option's 
title. 

As with the File and the Edit menus, you cannot 
choose options that are not applicable. Options 
that are not applicable will be shaded, and no letter 
will be highlighted. 

The sections below explain each of the options. 

The Select Database option allows you to select a 
database when creating or inserting fields. You 
should select a database before you select the 
Create Field or Insert Field options. Below is a list of 
folder names and the corresponding databases. 

Folder Name Database 

Permits PERMIT 
Inventory PERMIT 
Inspection INSPECT 
MIT MECHTEST 
Compliance/ COMPLY 
Enforcement 
Operations OPERATE 
Non-UIC NONU IC 
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If you want to add fields to a particular folder, 
choose its corresponding database. 

If you have used Insert Field, Create Field, or Load 
Page, then the Select Database option is not 
applicable. It will be shaded in the menu, and the 
"S" will not be highlighted. 

The Insert Field option inserts existing fields onto a 
new page. Use the Select Database option to 
specify the database locations for the field(s) you 
want to insert. If you do not make this designation 
before using the Insert Field option, a pop-up 
window will display the database names for you. 
You must select a database before continuing with 
the Insert Field option. 

After you choose a database, a new window will 
appear with a list of database field names and 
descriptions. Highlight the field name you want to 
insert and press I Return I. The Screen Editor 
places that field where your cursor was prior to 
selecting this option. 

TIP: When you insert a field. you are not jus1 inserting 
its format and color from WATERS; you ore also 
inserting the well-specific data on your new 
page. 

The Create Field option allows you to create and 
define a new field. Before creating a field, you must 
designate a database using the Select Database 
option. If you do not select a database through the 
Select Database option, the Create Field option will 
generate a pop-up window that lists the available 
databases. After you have chosen a database, a 
new window lists the following field attributes: 

• .Field Name 

• Long Field Name 

• Type 
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• Length 

• Decimal 

• Display Format 

• Required 

• Field Color 

The Field Name is the official name of the new field. 
This is the name used to identify the fields in the 
WATERS database. This name must start with a letter 
and have no spaces. The body of the name can 
have letters A to Zand numbers l to 9. You cannot 
save two fields with the same name. 

TIP; Once you hove saved a field name. you cannot 
alter it with the Revise Field option. You con onty 
delete the field. 

The Long Field Name is the description of the field. 
Unlike the Field Name. the Long Field Name does 
not have to be continuous. Describe the field as 
accurately a;: :)ossible, because the description will 
be used late• ·::>r exqmple, wran you create 
custom repor-;;. these field descriptions would head 

the data columns; when you press [EJ, these 
descriptions would ap~':'·ar in the pop-up help 
window. 

The Type ct-· .. ..Jute specifies the type of field: 
numeric, loc::;:cal, date, or character. 

The Length aefines the length of the t:~ld. Eacn field 
type has different length limitations. See the table 
below: 

Type Length 

Numeric 1 to 25 
Logical 1 
Date 8 
Character l to 74 
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Decimal 

Display Format 

Required 

Field Color 

Chapter X. WATERS Screen Editor 

The length of a field includes the space for decimal 
points in numeric fields. However, length does not 
include commas for numeric fields, or slashes (/) for 
date fields. 

The Decimal describes the number of allowable 
decimals in the numeric fields. This is applicable for 
numeric fields only. The default is 0. 

The Display Format describes the format you want 
the field to appear on the screen in, if any. Press 

[£1J for a list of all formats applicable for the field 
type you selected earlier. Once you select a 
format. an example of it appears to the right of the 
Display Format option. You can leave this blank. 

A Required designation identifies fields as required. 
Once a field is designated as required, you must fill 
the new field in order to save a record in WATERS. 
For example, "Rule Authorized" is a required field. 

The field color function allows you to choose the 
color you want a particular field to be. Press the 

[£1J key to designate a color for a particular field. 
For more detailed instructions on how to use the 
color chart, refer to the Color menu section. 

To create your field, specify the characteristics you 
want and press I Control 1- W to save. In order to 
save, you must specify the field name, type, length, 
and whether or not it is a required field in WATERS. 
The Screen Editor places your new field where your 
cursor was prior to selecting the option. 

TIP: For examples or field names and long field 
names. access the Insert Field option. or turn to 
Appendix 8. 
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Move Field 

Erase Field 

Revise Field 

Color Menu 

Chapter X WATERS Screen Editor 

The Move Field option repositions fields on a page. 
Use this option if you want to move a single field. If 
you have several fields to move, use the Move Area 
option instead. To select the field you want to 
move, place your cursor in that field before you 
select this option. Once you access the Move Field 

~ption, use the ~ [B, [Il and [!] to move the 
field and press I Return I to place it. 

The Erase Field option erases the field name and all 
the attributes you designate prior to selecting the 
c :·tion. A pop-up window will ask you to confirm 
that you want to delete this field. 

The Revise Field option displays the list of field 
attributes available for editing. If you try to revise a 
field you have added, you can change all attributes 
except the database designation. (You can only 
change the color of core fields.) 

To revise a field. place your cursor in the field to be 
revised. Once you access the Revise Field option, 
you will see the list of field attributes available for 
editing. Make the necessary changes, and press 
I Return 1. 

The color menu allows you to alter the background 
and foreground default colors of any single page, 
and all the fields on a single page. This page can 
be part of the core page or your own additional 
pages. The colors of a page and its fields are unique 
and specific to that page. To change all the pages 
in WATERS to different colors, you must change the 
colors of each individual page. 
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Color Chart 

Chapter X. WATERS Screen Editor 

TIP: The Color menu wiH change the co&ors of fields 
with the default color. However. you con assign 
certain fietds specific colors -with the Creote field 
and Revise Field options. These specific field 
colors will not change when you use the Cok:>r 
menu option. For example. if you make the .. Well 
ID" fiek:J yeDow. and the default cokx of the other 
fields is red. 1hen the Color menu will only change 
the red fiekis to a new color. 

The Fields menu hos two options: Screen and Fields. 
You can access these options the same way you 
access menu .options in WATERS. 

1 . Use [II and [!] to highlight the option you wish 
to select and then press I Return I. 

2. Press the highlighted letter of the menu option's 
title. 

When you select either option, the same window 
appears with a color chart for both the foreground 
and background. To switch between the 

foreground and background colors, use the ~ 
and fB. To select a color in either column, you 
have two options: 

• Use your [II and [!]to move the triangle to the 
color you want 

• Type the capitalized letter adjacent to the color 
you want. 

At the top of the window, the Color Selection 
Example box lets you see how different 
combinations look. When you have marked both 
the foreground and background colors you want, 
press I Return L 
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On-line Help 

Chapter XI HELP 

XI. HELP 

If you have problems running WATERS, there are two 
sources of on-line help: the WATERS and WMS Help 
menus, and WATERS on-line help. The Help menu 
provides a synopsis of key commands and 
:xocedures. On-line help descri;:)es fields, or if 
applicable, lists their data entry codes when you are 
entering, editing, copying or querying a record. 

Since the Help menu has already been described in 
Chapter VI, this chapter focus~s on on-line help and 
DOS trouble-shooting tips. 

WATERS on-line help provides users with field 
description~ or pop-up lists of data enrry codes for 
use in performing queries or using the Edit, Add, 
Copy options. To access on-line help, place your 

cursor on the field in question and press [E!J_ 

Many WATERS fields, such as "Permit Number" and 
"State", do not have established data entry codes. 
For these fields. the on-line help displays a pop-up 
window containing the appropriate field 
descriptions. You can press any key to remove the 
window. 

Fields that are restricted to a set of defined values, 
such as "W"": Class" and "Type", will display a pop­
up list. Exhit>ii Xl-1 below is an example of a pop-up 
data entry code list. 
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Chapter XI HELP 

Exhibit Xl·1 

t Up Flcl - IAft Cl\ortrlcl 1'9Dn Next Page Pl Help 
l Down fld .. Rght Char/Fld he Exit w1thout changes Ine Toggle Ov•r 

Rule Author1ze-d 

Application Number 
Penn1 t NUDlber 
'l'ype of We 11 Penn: 
No. o: We!ls1Pen:i1t 

Appl1cat1on Oate ·.· :'./ I 
Date Permit Issued .... I::/ 
Date Penrut Etfecto.ve ·.·.·1 ·=··!. 
O.te Permit Mod1!1KS .... :: .. './. ·;./.:.:: .· 
Type of Per>11: Hoel f 

Date Plugged/Atktndonctd ·::: .... /: ... l.:·.;·. 
Cowaerc1al Fac1 llty 1. 

w.11 1c1ent111er il'ln~s)'"·( .. , 
~ of Well Pt"91td r.i:>'nveTt'e<t 
Class l 

Type ~~,~-----------
2A Annular Inject ion 
2D Salt Water Dl•po .. 1 
2• L1QU14 Rydrooarbon scorag• 
2a &Dbanced Jlecoveey 
2X Ot.ber Claa• II 

Teen 
Publ 
Pub! 
P..-111 

E:xp1c:=:::::::::::::::::::::::1 
Date Pf'nnlt Ofon1ed · ·., .. :; .. ·:· 

D•te W1thdr•wn · /.. "' ... 

L!::::==::==::~===~==================:=....i~ ··· :mc·. · .. ·· llon-UIC Ech t !itenu 

When the on-line help produces a pop-up list you 
have two ways to select a code. You can either 

type the highlighted letter, or use [!]and l1J to 
highlight the option and press I Return I. If you 
select a letter that is not a valid option (not a listed 
code), there will be no response. In order to return 
to the data entry screen without selecting an option 

press I Escape l . 

The pop-up list is a tool to help you in the data entry 
process. not a necessary step to add, edit, copy or 
query a record. If you already know the code, you 
can simply enter it. However, even when you know 
the appropriate codes, using the pop-up lists is faster 
whenever the codes are more than two letters. To 
select a code from the pop-up list, you only need to 
type the single highlighted letter. 

For example, press WJ in the Frequency of MIT 
Tests field on the second page of the Permits folder. 
You will see the options Annually, Semi-Annually, 
Every 5 Years, and Other. Type A, S., f, or Q to 
choose an option. WATERS automatically writes the 
full two-letter code on the 5':reen. 
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DOS Trouble· 
Shooting Tips 

File Handles 

Chapter XI. HELP 

You also have the option of typing the first two 
letters of the option in order to select it (i.e., AN for 
annually). Again, WATERS displays the full field value 
on the screen. 

DOS commands can be used to alter your 
computer's configuration so that -:an 
accommodate the WATERS prog.- ~ 'TI requirements. 
There are three trouble-shooting tips about DOS that 
may help you use WATERS more easily. They are the 
SHARE program, the UTILITY PACK program, and File 
Handles. 

If you are having difficulty running WATERS, the most 
common problem is insufficient memory dedicated 
to the WATERS program. If you do not have enough 
memory to open the necessary WATERS files, your 
system can send you many different and confusing 
messages while running WATERS or WMS. For a list of 
these messages, see the table on the following 
page. 

What 

WATERS message 

WMS messages 

98 

Details 

DOS Error 4: Too many 
open files (no file 
handles left). Increase 
FILES= in c:\config.sys 
and/or File Handles= in 
c:\shell.cfg. 
Unable to open file 
Error reading file 
Error opening 
WMS.NUM 
Error reading 
WMS.NUM 
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Option 1 : Check your 
c: \ conf ig. sys file. 

Step 1: 

Step2: 

Step 3: 

Step 4: 

Option 2: Check your 
network directory. 

Step 1: 

Step 2: 

Step 3: 

Step 4: 

Option 3: Consult your 
LAN administrator. 

Chapter XI HELP 

There are three ways to change the amount of 
memory allocated to run WATERS. Each are 
explained below, in the order you should try them. 

The config.sys file controls the number of files that 
can be open at one time. To run WATERS, you need 
at least 83 file handles. To check your conf ig. sys 
file, follow these steps: 

Quit WATERS and return to DOS. You should see c: \ 
on your screen. 

Type edit c:\confiq.sys and press I Return I. 

If the number at the end of the Files = line is less 
than 83, edit the line so it reads Files = 83. 

Start WATERS. If you are still having memory 
problems, see option two below. 

The shell.cfg file in your PC network directory allows 
you to open a certain number of files. To check the 
file handles in shell.cfg, follow these steps: 

Quit WATERS and return to the DOS prompt. 

Type edit c:\shell.cfq and press I Return I. 

If the number at the end of the File Handles = 77 
line is less than 77, edit the line so it reads File 
Handles = 77. 

Start WATERS again. If this does not work, see option 
three below. 

The LAN administrator may not have allocated 
enough file handles to open the files you specified in 
your config. sys or shell. cfg files. To run 
WATERS, your LAN administrator will have to increase 
the number of file handles available. 
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The SHARE 
Program 

UTILITY PACK 
program 

Chapter XI. HELP 

SHARE is a component of DOS that allocates file 
space for file-sharing information. It is 
recommended that you do not run the programs at 
the same time, since combined with WATERS, it can 
produce erratic results. However, DOS 4.0 
automatically loads SHARE, so this may be 
unavoidably. Regardless, if you do run SHARE while 
using WATERS, you should increase the capacity of 
the SHARE program by typing 1£:... and the increased 
number of bytes SHARE needs .. There is no hard­
and-fast rule for the number of bytes needed, but 
the longer the WATERS path name, the more space 
SHARE requires. Refer to your DOS documentation 
for more details on SHARE. 

When you delete records in WATERS, your hard drive 
still marks the space these deleted records took up 
as occupied and the Tally option counts the deleted 
records. It will continue to do so until you use the 
UTILITY PACK program. This program will "re-pack" 
that disk space, i.e. compress the records of all 
database files by permanently removing the 
deleted records. UTILITY PACK frees up disk space 
and can even increasing system speed. Therefore, it 
is a good idea to use the UTILITY PACK program 
once every one to three months. The more records 
you delete from WATERS the more often you should 
re-pack your database. 

To repack, type Utility Pack at the c: \WATERS 

prompt. If by mistake youtype Utility, the program 
will ask if you want to delete or pack. Type P. 

TIP: It is crittc:al that you do not type D because yoo 
wil defete al your data! 

The UTILITY PACK program also deletes WATERS' 
internal index files. When you load WATERS next, it 
will automatically reindex the database. Like the 
first time WATERS was loaded on your machine, the 
loading process will take longer than it normally 
does. 
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Appendix A WATERS Training Script 

Appendix A. WATERS Training 
Script 

This training script gives you step-by-step instructions 
for many WATERS features. All new WATERS users 
should review the entire script before starting to 
enter well data into the system. After you become 
an experienced WATERS user, this script will serve as 
a handy reference tool. 

Topics covered in the script include: 

• Moving Between Folders 

• Moving Between Pages of a Folder 

• Adding a New Well to WATERS 

• Copying a Record 

• Editing a Record 

• Listing a Record 

• Finding a Record 

• Savi11g a Query 

• Loading a Query 

• Deleting a Query 

• Deleting a Record 

• Printing a Well Schematic 

• Producing 7520 Reports 

• Producing a Custom Report 

• Quitting WATERS 

Each section tells you which keys to press and what 
options to select to complete a particular function. 
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The script also contains many examples of WATERS 
screens to further assist you in learning to navigate 
and use the system effectively. 

This script shows you how to perform most WATERS 
functions. To simplify the script and avoid 
redundancy, each function is usually described for 
only one folder. However, you can use these 
functions in all of the folders. If there are any­
notable differences among the folders, they will be 
discussed at the end of each section. 
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A. Moving 
Between UIC 

Folders 

Step 1: 

Appendix A WATERS Training Script 

WATERS contains six separate UIC folders that store 
different sets of data elements. When WATERS starts, 
you are in the Permits folder. To see all of the data 
for a particular UIC well, you need to be able to 
move freely between folders. In this example, you 
will move from the Permits to the Inventory folder. 

Access the Inventory folder. There are two ways to 
do so: 

• 

• 

Type L the highlighted letter for the Inventory 
folder. 

Use the ~and ~to highlight the Inventory 
folder. Then press I Return I. 

With either method, the screen below appears. 
Notice the taller box for the Inventory folder. The 
taller box indicates that the folder is active. Also 
note that the number 1 on the right side of the 
screen is in a red box that is wider box than the other 
page tabs. This indicates that you are on page one. 

Exhibit A·1 

; n•pec: ion 

State UT ~oun: v 
Region 11 Dis:. r:=~ 

?art l: IC Info~.at :on 
F1 nds Ne. Field Name 

f'ecll Land 
Indian Land 

AP! Numbe:: 43 0:7' 6517 
Fac1!1ty ID 
Ownership Private 

Par4; 2; :....Ocat.iona! :n!or.nat1on 
Sect ion 28 
Townsh1 p 42 S 
Range 22 E 

~14 './4 

I~ Wellhead Protect:cn A ea Y 

Meth of Co! lee t ion Cadastra I Survey 
Accuracy 
Descr ip: ion 
Lat lt ude 
Longi cude 

Publ1cWterS lvWells1nAOR 

1Jl<:" Non-c;c S1.'1:ch :o !nve~tory for this Wel! 

Step 2: Type .E. to return tp the Permits folder. 
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You can see from the screen below that you have 
moved back to the first page of the Permits folder 
(the Permits box is taller and the number 1 is both in 
a wider red box). 

Exhibit A·2 

ac;;; A ... ~ !dentifier t:T02337 
:;;99-50~-.i :..,·.,.,cf Well Pnntd Convened 
ind.:. ·n d1..d: :-: dSS 2 

No. of Weiis/Pernu: 

Application Date !9o7. C~ JS 
Date Pernut Issued :96~ :- :~ 

!late Pernut Et fec::ve !96~ ca :~ 

Ddte Pernu: Mod1f:ed 190'1 :· ·-
1';pe of Penn:: Mo::i Pe,-,,,:: -,. 

Date Plugged/ A bar.dc::e:! 
Co::111erc :"! F'ac:; i :y 

J!C . :c~ :o Pe:-.. : 

:'fpe 2H Liquid Hydroc 

:-.. =~·11c .. 1 Review -:.967/01/15 
?-..1:: :c Not ice 1967/06118 
..-... :11c Hearing 1967/071:7 
;., :"'II: Term S Ye.,rs 
E.x;;iration 1993/03117 

:d·-" Penni t Denied 
:d:"' W1 thd :-awn 

...... 1: 

You can move among all six UIC folders using this 
proces~. In acdition, if you'-" '.:;h to view all of the 
screens in all of the folders, s:art with page 1 of the 
Permits folder and press I Page Down I. WATERS takes 
you through all of the folders sequentially, allowing 
you to see each page of each folder. 
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B. Moving 
Between Pages 

of a Folder 

This section describes how to navigate between 
multiple pages of data elements in a folder. 

Pi le 

0 
0 

This example starts in the Permits folder, which is in 
Exhibit B-1 below. Note the numbers on the right 
side· of the page. The number 1 is highlighted and in 
a wider red box, indicating that you are currently on 
page l. 

Exhibit B·1 

Rule Authorized 

Application Number 
Pennlt Number 
Type of Well Pennit 
No. ot Wells/Penni t 

Application Date 
Date Pe rThi t Is sued 
Date Pe nru:: E!'tec:ive 
Date Perm.:t Modified 
Type cf Pe!111.1 t Mod 

Date Plugged/Abandoned 
Corrrnerc ial F'ac i :i::y 

867585 Well !dent ifier UT02))7 
UT89756nw 'l'ype ot Weil Pnntd Converted 
Individual Class 2 

Type 2H Liquid Hydroc 

1967/0~/05 Technical Review 1967/01/15 
1967/07/26 Public liet ice 1967/06118 
1967/08/25 P°Jbllc Hea nng 1967/07/P 
1969/07 ;07 Pemit Term S Ye a rs 
Permit Tra E.xpi rat ion 199)10 J/:: 

I I ~ate Penni t Denied I I 

N Date Wlthd rawn I I 

VIC Son -UIC Swi t c'i to Perm.:: for Th!: We 11 

Step 1: Type 2 or press I Page Down I. 

This moves you from page one to page two. Your 
screen will look like Exhibit B-2. The page contents 
have changed. Now the number 2 is in a wider red 
box. 
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Exhibit B·2 

Pile llcli t Query 

Pennies KlT Comp! /En! 

p: Co llJ!!lbus Energy Corp. 

Frequency of MIT Tests Annually 
Well Coordinates La:tLong 37°10'49.3158" t 109°33"20 .3061" 
Latitude/Longitude :late 1937 /02/03 

lnJect ion Data 
Iniect ion Pressure 500 psig 
Inieco: ion Rate/Measure 450 bbls/day 

Recording Prequenc y 
Iniect ion Pressure Weekly 
Flow Rate Month l :; 
InJect lOn Volume fo!ont~:·,-

',VlC. ... : ...... Hon-UIC SW I :ch t 0 Penr. i: for this Well 

Step2: 

Step 3: 

Type l or press I Page up I to move back to the first 
page of the Permits folder. 

To move to page 3 or 4, select one of those numbers 
or use the I Page Down I key. 

Try changing pages using the number keys, 
I Page Up ! and I Page Down I until you are 
comfortable with the process. 

Moving from page to page in the Inventory folder 
involves e.x Jctly the same process. The only 
difference :s that the Inventory folder contains six 
pages rather than four. 
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c. Adding a New 
Well to WATERS 

Step 1: 

Step2: 

Appendix A WATERS Training Script 

When you need to enter data for a new well into 
WATERS, use the Add function. The first folder you 
should enter new well data into is the Permits folder. 
WATERS will not allow you to enter data for a well in 
other folders unless the Permits folder contains a 
record for that well. When you add a permit record, 
an inventory record is automatically created. After 
entering data in the Permits folder, you should then 
enter data into the Inventory folder. 

This example explains how to add a new well record 
to the Permits folder. 

Type E to move to the first page of the Permits 
folder. The label for Permits folder will be highlighted 
like the screen below. 

Type .E. to access the Edit menu. Exhibit C-1 below 
shows Edit menu options. The Add function is 
located under the Edit menu. 

Exhibit C-1 

Fi~e .Bdit O:..e:-·. !I~.~ :s:.::========WATERS Std:te Syster.i::::ss=================== - -
Md ..__~~ 

CO;>y 
lid'. 

P Delete ?R:;.F"." :s; :'1'0215 l 

To!ol .. 
r: :ea ~ 

Application~""'°"' 147853 
Perr.ut Nurr.oe:- :..""!'::34A 
·~pe of we:: Pl!!>:T.1': A:-ea 

fio. of Wel:s;?e<'.T"..lt 

App: icat :.on Jd:.e 
Dd:te Perrr.:t :ssued 
Date Per rr.:. t Ef f ec:. l ve 
:J4te Per:n1t Mod1t1ed 

~te PluggedtA.bd:idor.ed 
Commerc:a: Fac1l~ty N 

UIC Bon-UIC Add a Record 

WATERS User Guide 

Well Icien:,fier L"l'02JS J 
Type of Wel 1 Pnntd Converted 
Class 
Type 2~ Enhanced Reco 

Technical Review I I 

Pub! ic Not >Ce I I 
Publ>C Heari::; I I 
Pe mu t Ter!Tl 10 '!ea rs 

Exp1 rat !On 

U4te Perm1t Oen1ed 
Date W1 thdrawn 

; I 

I I 
I I 
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Step 3: 

Appendix-A WATERS Training Script 

Choose the Add option by typing A or by pressing 

lIJ and [1J to highlight Add and then pressing 
I Return 1. When you select the Add option, you 
get a blank screen like Exhibit C-2. You can enter 
data into the red fields or spaces. You must enter 
data into the pink fields in order to save the record. 

Exhibit c . 2 

T Up Fld - Lett Char/Fld PgDn Next Page Pl Help 
l DCMll Fld - lght Char/Fld BE Exit Wltl'lOut C:h"19es Ina Toggle Over 

Pe1:1111 ts 

Rule Authorized 

AR>l 1c:at 1 on Nullt>er 
Per111t Numer 
T)'Pe o ! w~ I Permit 
llo. o! We II s/ Per111 t 

A;pl1c:at100 Date 
Date Per111t Issued 
Date Pera11t et fec:t1..., 
Date Per111t Hoch! ied 
T)'Pe of Perm t Mod 

Oat e Plugged/ Al:l!nooned 
Ca111ercia l Fae: 1!: ~ 

till:. lbn-UIC Edit Menu 

···::; 

· ... . 1 ,, . 

q:>e rat ions 

Well Idont:tier •. , ..... ,, .. ,., .. , ... ,; .... ,.. .. · 
'fy pe of We II Pro•: d :. 
Class 
'fype 

~d'ln1ca.l Review 
P\Jbl IC: Not IC:e 
Pub! 1 c: Hear: ng 
Pet1111 t ~n• 
E:lp1 rat ion 

Date Pemlt D<n1ed 
Cote Wi tl'ldrawn 

•r·i 
• , i 

Step 4: Enter a y or at:! in the 11 Rule Authorized" field, and 
then enter data in the remaining red or pink fields. 

Step 5: When you finish entering· data on the first page, 
press I Page Down I to move to the second page. 
Continue entering information and pressing 
I Page Down I until you have reached the fourth page. 

Step 6: Save your new record when you finish entering data 
on all pages. To save the record, press I Page Down I 
or I Control I - W. A menu appears presenting you 
with three choices: Save, Discard, or Edit. See 
Exhibit C-3 for an example. 

A-8 WATERS User Guide 



Appendix A. WATERS Training Script 

Exhibit C·3 

f Up Fld 
l Down Fld 

Left Char/l'ld PJDn Next Page 
R9ht Char/Fld Ille EXlt without chanlJeS 

P'1 
ID.o 

Peca1ts OpPrat ions 

Step 7: 

Ruh Authonzod 

App heat ion N1.111fr.;==:=::;;;;;;;;;::;;;;;;;::;;;;~=:=:=:=:=:=::;:;-!;!,~··'~:2 
P.rmi t N1aber II Save cnan~s 11 
Type of Well Pe I) '-="'·I r::--:i. r--Ed_i_t ....,I 
No. o ! Wei b I Pe 1L..o:i----··•.L-....:i'*7°'.Dl•SlliilC4ilir•d L.....:..--111.UJ .. 

Apphcat ion Date 
Date Pltnn1 t Issued 
Date Peorrut £f!ect1ve 
Date flre.rir.1: Mod: f:.ed 
'TYP• of P.Pm1t Mod 

Date Pl u99ed/ Aoa:1doned 

Cownerc1al rac1l1ty 

.. .. 't. I·· , '.r::, 
···:; ·.J·· ·. 

:i J: .. ··. 

t i. :> 

Techru cal feVl ew 
Publ 1c Not ice 
Publ :c Hiia n ng 
PeD11: 7er1r1 
£xp1 rat :.on 

Date Pecni t {)eon ied 
Date Withdrawn 

a 

( f.i·: 

=•~{ 
Yeu~ 

I 1 ... 

i .I 
··:f: 1:.: .. ·. 

Type S. for save or use the ~ and ~ keys to 
highlight the Save option and press I Return I. 

Once you have created a record in the Permits 
folder, you can begin to add records to the other 
folders. Follow steps 1 through 6 above to select a 
folder, execute the Add function, and enter data 
into the open fields displayed in red. 
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D. Copying a 
Record 

CopyinG sll record is an easy process that can 
save date -:try time. This function copies the 
information in the current well record into a new 
record so you do not have to retype data for a well 
with similar characteristics. 

You can use the copy function to copy well 
information in all folders except the Inventory folder. 
When you try to use the copy function while in the 
Inventory folder, WATERS automatically moves you 
to the Permits folder to execute the copy function. 
And when you copy a record in the Permits folder, 
WATERS automatically copies the Inventory folder of 
the well. 

In this example, you will copy a well record in the 
Inspections folder. 

Step 1: Type ~to choose the Inspection folder. 

Step2: Type f to access the Edit menu. 

Step 3: Type ~ to access the Copy option. The copy 
function will be highlighted as it is in Exhibit D-1 . 

Exhibit D·1 

rile lldit. I Q'-ler,- I •~.;. I =••••=ic:====2=WATERS State Sys tern==•ic:= ========= ==ic:• 2 === •=I- -I· -
Adc:i 

c ·.·.,--- ,.... ii · -•r•~" ~~ I 1 Penni e,-,,.,v KJ':' I I Como: ; E n ~ I I OOerc:': ~onz I 

-Op :lei:~ 0 .. ?RO? ER:": S3 :T02l 53 - [Ell£] 
Delete 

·: :8 ----- - :.f .;.er U-:'02353 

.~ 
Table d Updated 1992108112 

·~ .. nsi::ec .. o: Name/ No . ..7oe C./9897 

·~ 
=~ O..te of Inspect l on 1992/06/17 

;~ Type of Inspect 1 or. ::R Comp! 1a nt Response 

: = ) : =) Complaint Reso: u: :.on •el! contaminated 
: = Time R equ l red 2 days 

:~ Emergency Resol ut1cr. 

Time Required days 
: ) 
: ) 

Viol. Ciscvd/Present ? 

;~ Action T!lken Operator to Correct 1non-v1 olat ion) 

~ 
;'·vJ:C . I Bon-UIC l::opy C.Jrrent Record I 
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Step 4: 

Appendix A. WATERS Training Script 

Change the necessary data to make the new 
record unique. The fields in pink (in this example, 
"Well ID" and "Date of Inspection") are fields you 
must change. Those in red are ones you can, but 
are not required, to change. See Exhibit D-2. 

Exhibit D·2 

i..ef: Char!Fld P!IDn Next Page Help f Up F ld 
l Down Fld Rght Char/Fld •11e Exit without changes 

Pl 
Ina Toggle Over 

Perm1 ts Inve ~~G rv KlT comp; /Ent 

Step 5: 

Op: ::JIJNCAN O!L PROPER'!':ES 
Wel: :der.~;!ier 11TC380 :: ... 
Date Re:::ord 1.J;::dated l.i')2/Q&1t·2. 
I nspec: or Name /No. JO<!.! c .. (9!J9? · 

Date of Inspect:on 
Type of Inspection 

Complaint Resolution 
'!'ime Requ1 red 

Emergency Resolution 
7:me Rec;u: red 

Vio:. Jis:::vd/Preser.t 

Act 1or. Take~ 

i,99uo&ii7 
Ci! Can pl l ant Response 

weu·~~~~~.i 
2 ciays · · · · · · ·· 

days 

., 
Opera >:er :o Cor~ect !non-vi cl at :or. I 

When you are finished, press I Page Down I or 
I Control I - W. As shown in Exhibit D-3, a pop-up 
window presents you with three choices: Save, 

· Discard, or Edit. 

WA TEAS User Guide A-11 



Appendix A WATERS Training Script 

Exhibit D·3 

f Up Fld 
l Down Fld 

Le ft "Char /Fl d l'VDn Next Page 
Rght Char /Fl d .. c Exit without changes 

I nventorv 

Date of In 

Type of In 

Emergency Resolution 
Time Required 

In•pection 

Viol. Discvd /Present ~ 

KIT 

Sdit I 

Action Taken oPerator to Correct t non-violat ionJ 

" : .:·ar<i:.:/: Non -UI c Edit Men 

l'l 
:i:n. 

Help 
Toggle Over 

Type S. for save or use the ~ and [B keys to 
highlight the Save option and press I Return I. 
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E. Editing a 
Record 

Appendix A WATERS Training Script 

This function allows you to correct mistakes and to 
update records as information changes. In this 
example you will edit a record in the Inventory 
folder. 

Step 1: Type ! to choose the Inventory folder, which is shown 
in Exhibit E-1 . 

Exhibit E-1 

: r.•pec: ion 

~orp. 

L":'8975 647W 
N 

Part i, ID Information 
F: nds No. 
AP! Nu:nber 4303716SJ7 
Facility ID 
ownersh :p Pr 1 vat e 

Part 2, Locationa: Infonnat:or. 
Section 28 

42S 
22E 

1'4 : I~ 

W~l l head ?:-o: ec':. ion A :ea ':' 

State ~"'!' County 
Reg10~. :1 Dist r1ct 

Field Name 
Fed! i..and 
I nd1an Land 

Meth o! collection Cadastral Survey 
Accur acv 
Descr1pt:on 
Lat:~c;de 

i..ongi :u::ie 

P.Jt·.::: Nate-r Suoolv Wells :"'I A0~ 

tJIC Non~U!C Sw:tc:-i to i!"lventory !or :~is w~:: 

Step 2: Type .E. to access the Edit menu. 

Step 3: Edit the appropriate fields. You can change the 
information in any red field. 

Your screen will look like Exhibit E-2 on the following 
page. 
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Exhibit E·2 

I napection 

Appendix A. WATERS Training Script. 

KIT canpl/En! 

State fi. county 
Reg ion U Di stn ct 

Field Name 
Fedl !..and 
Indian Land 

Part 2: Loca~,i..onal Infonnat ion 
jjdastral Survey 

10 
sect ion J.!.., 
Township m 

Meth of Collection 
Accuracy 
Description 
Latitude 

Range ~ ~R~J(a.i 
37°10 '49. 3158" 

109°33 ·20. 3061" 

Step 4: 

Longitude 

When you are finished, save your changes by 
pressing I Page Down I on the sixth page, I Page up 
on the first page, or pressing I Control I - W. A pop­
up window presents you with three choices: Save, 

Discard, or Edit. Type S for save or use the~ and 

~ keys to highlight the Save option and press 
I Return I. 
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F. Listing a 
Record 

Step 1: 

Step 2: 

Step 3: 

Step 4: 

Appendix A. WATERS Training Script 

Listing records enables you to see a summary of all 
the records in a particular folder and lets you 
choose a particular record to view in more detail. 
The same process is used for listing records in all of 
the folders. However, the output varies across 
folders. 

This example shows how to list the records in the 
Compliance/ Enforcement folder. 

Type C to choose the Compliance/Enforcement 
folder. 

Type Q. to select the Query menu. 

Type l. or press [!]and [!] to highlight the "List" 
option and press I Return I. 

A list of all the records in the 
Compliance/Enforcement folder appears. See 
Exhibit F-1 for an example. You can scroll through 

the records using the [!]and [!] keys . 
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Appendix A. WATERS Training Script 

Exhibit F·1 

Pile I 8dit l::::o~~t·.:t Belp I============= wATERS State Sy stem=•===== ======•.11 =I~ -I· ~ 
,/ 'OTO:ll 37 Occurred Type of Violation En force Type of En force ~ ---- ---- ---- ---- --- ---- ---- ---- --- ---- ---- ---- --- ---- ---- ---- --- ---- ---- --------

UT02337 l 990/ 09/0 l Pressure and/or 1990/11/02 CR Criminal Ref 
•. ·.~2~u1. l.~tO•t~J. :.,. : • . YAO:-'•~ . ...., "'> .. 

·~ ... ~ ... .. 

UTC2337 1989/01/01 Mechanic:a 1 Inte 19 89/0 2/03 LI:) Unilateral c 
1JI'C 23 40 1987/10/09 USDW Cont aminat 1987/10/09 SI Shut-in 
UT02340 1982109/18 Falsification• 1982/l 0/15 LI:) Unilateral c 
UTO 23 46 1993/05/16 Penni t Vi olat io 1993/06/18 AO Adrni n1st rati 
UT02346 ! 979/ 05/2 3 Mechanical Inte 1980/01/15 CR C rinn nal Ref 
UT02347 l 989/ 08/1 9 Operation and M 19 89/0 8/23 AO Admi nist rati 
UT02348 1 993/ 02/l 5 Casing and Ceme ! 9 93/0 2/15 LI:) Unilateral 0 
UT02349 1987/ ;2112 Casing and Ceme !990/12/12 C) Consent Orde 
UTO 23 50 1 990/ 03/2 5 USCXol Cont aminat 19 90/0 8/16 SI Shut -1n 
UTO 23 52 1992/07115 Monitoring and 19 9 3 /0 1 /l l AO Adml nist rat i 
UTO 23 52 l 99!/ 03/0 ! Operation and M ! 9 92/0 8/01 JO Judi c1al Ord 
!JTO 23 52 1985/ 03/l 8 Casing and Ceme 198510'!10 PS P1pel1ne Sev 
UT02353 1 992/ 07 /l 7 Falsification• 19 92/0 8/31 CV Civi 1 Re ferr 
UT02636 1 990/ 04/l 1 Mechanica 1 Inte 1991/l 0/09 CD Consent Deer 
UTO 26 36 1 990/ 04/01 US~ Contaminat 199010 7 /01 LI:) Uni! ateral 0 
UT02678 l 984/ 09/l 2 Mechanical Inte 19 85/12/30 CD Consent Deer 

~ 

.. ,.: •. 01c · 'j Non-UIC louery Menu I 

Step 5: Scroll through the records by typing part of the well 

ID's or using the [!]and [j] keys. When you find 
the record you wish to select, press I Return I. 
WATERS displays the Compliance/Enforcement data 
for the selected rec.:Jrd. 
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G. Finding a 
Record 

Step 1: 

Step 2: 

Step 3: 

Step 4: 

Appendix A WATERS Training Script 

This function enables you to select a record, (or 
group of records) meeting criteria you specify. It is 
useful if you are trying to locate a set of wells with 
similar characteristics. The procedures for the Find 
optio,n are the same for all folders. This example 
uses the Operations folders. 

Type 0 to choose the Operations folder. 

Type Q. to access the Query menu. 

Type E to select the Find option. 

Type your search criteria in the appropriate fields. 
All searchable fields are in red. In this example, type 
an asterisk (*) in the "Operating Status" field; your 
screen should look like the one below. This asterisk 
indicates that you want to select any record with a 
value in the that field. 

Exhibit G-1 

f Up fld - l.~!~ '.l'lar/f"ld Pgt>n Noxt Pag~ Pl H~lp 

l :lOoin F .. d ~ Rght ~ar/fld Ea: Dc::.t without d'lo11"11es Im T091le OVer 

Per111::.t s Coupi !Ent Ope rat lOOS 

W.l l :dent i her 
Dote Up:laad I I 

~=~~;·~11;~;: I I 

Ml nunu111 
Average 
M6XlJl'IUJI 

L"'l)ect:on Press1.1~ 
(p51g) 

Annual Voluzne o! 
ZrlJectec! Flwd barrels 
nu1d Ty~ 

1 nJect1on Rate 
(bbl•!doy) 

Amulus Preossure 
(ps19) 

Step 5: Type I Page Op I or I Control I- W. A pop-up 
window asks you to verify your query. It presents you 
with three choices: Search, Clear, or Edit. See Exhibit 
G-2 for an example. 
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Appendix A WATERS Training Scrrpt 

Exhibit G·2 

IA~ O\.rtnd PgDn Nrxt Pa11• T Up nd 
l Dcwn fld Rght Cll.rtnd r..: D<it without dl•!'Q•• 

Pl 
Im 

Pvzut1 

Well lot,· _ !1•r 
Date U~<J.f::'d 

~:t~;·~¥r;~~: 

Mln111u11 
Av•raoe 
Kaxi.iuai. 

Annuol Vo!ullle ot 
ln)ected F!wd 
F1 Uld 'fy~ 

•. I J. 

Oprprat lats 

ulus P~ssure 
(psig) 

........................................................................................................... ~CEi:El 
·. :::v-i:c:. · · llai-UIC Qu.ry Honu 

Type ~ or use the ~ and ~ keys to highlight the 
Search option and press I Return I. 

Exhibit G-3 

P:!e I ll:d:: I ouer7 I Help l=•••~•••••••=WATERS State Systema••===-••==z••cc:a:• I~ -I·~ 
Per"':: s I I 1~·1ec.: ::::-: ll:~•cec~;:- I I HI'!' I I Compl/En~ I I Operations 

Explar.a::on c! r:'uer: :r1 :e:-: a - ~ 
Operat:ng Status ls ··- .,.,.p:y I 

==o Wei: ldent!!ler ·:i::o :late Updated ·I I ==o ~~=~~~,£~!~~~~! • 
==o I I 
•=O Ir.iec:ion pn Rate Annulus Pressure •• o 

rps Pass 111 /dayJ lpsigJ ••O 
:i::o Min:mum Process::ig 45/472 

..,o Average Matches 39 

==o Maximum 
<ESC'> to Cancel 

••O Annual Volume o! ==o ln)ected Fluid barrels 
==o :'lu1d Type 

"~"-

· .. . '::111(:'. .·.· · 1 Hon-UIC louery Menc; 
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Step 6: 

Step 7: 

Appendix A. WATERS Training Script 

WATERS indicates that it is searching for matches. 
When the search is complete, the number of records 
that match your criteria appears in the middle of the 
screen. 

Press any key to move to the Operations folder of 
the first record. In the top right corner of the screen, 
notice that the word Find appears. See Exhibit G-4 
for an example. The word find indicates thatyou 
only have access to the records found in your 
search. 

Exhibit G·4 

Pile Edit ··~~· Help ··-·-•:r••-WATERS State Syst•·-·-·-····-·· ._:·n_,,_.i..>· --'---4 

UT02353 
Dot<> Updated :992/04/19 
Q'.>enittng Sl:.atus Act:.·1e 

S::.at-..:s E!fe::;t1v~ 1~92/0~/18 

!n)ect ion Pressure 
ips1g) 

1500 

Annu.l Vo! u:ne of 

Iniected f!u1d 350.000 barrels 
Fluid "fype S•:< '"1t<>r 

In)ect1on Rate 
(bbls /day) 

75 0 l 

o erat1ons 

Ar.nulus Pressur'!' 
I PS19 l 

l 900 

VIC Kon-t:IC ().Jery """" 

Step 8: 

Step 9: 

To review the records, use the I + I and CJ keys. 
You will only be able to see the records that meet 
your search criteria. 

When you are finished reviewing the records, you 
should clear the search to regain access to all the 
records in the folder. To start, type .Q to enter the 
Query menu. 

Type~ to access the Clear Find function. Your 
database is no longer limited to the records in your 
query. 
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H. Saving a 
Query 

Step 1: 

Step2: 

Step 3: 

Appendix A WATERS Training Script 

Saving a query allows you to run the same query 
without reentering all your search criteria. It also is a 
convenient way to save an explanation of your 
search criteria. 

In this example, you will save the query you ran in 
Section H, which searched for any record with a 
value in the "Operating Status" field of the 
Operations folder. 

Follow the steps in Section G to run the sample 
query. 

Type Q to access the Query menu. Press 
I Return I. 

Type S. to access the Save Query option. Your 
screen should look like Exhibit H-1 . Press I Return I. 

Exhibit H·1 

P1l e- Reh:: Que iv- ••lp .1<.2. ····--·-WA:I'~S Stat• Syst•-·-------·· 

Well ldent1f1er 01'0235 3 
Date Updated 1992/04/ 19 
Operat1rr;i Statu• Active 

Stat".l.S Effect1v• 1992/05/18 

H Ull m.Jlft 

Awra;e 
Ha.x:.JDJi:ii 

Iniect 

AMual Volwne of 

Swe Query A•: 

Iniected Fluid 350 .000 bar"'ls 

Fluid Type Salt Wot er 

e Amulus PAssure 
(PS111) 

1900 

Step 4: Type Ooerating Status in the red field. This will be 
the name of the query. 

Step 5: Press I Return I. _You have saved the query. 

-
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I. Loading a 
Query 

When you want to access one of your saved 
queries, you use the Load Query option. This 
example builds on the query you ran in Section G 
and saved in Section H. Therefore, please work 
through those two sections before you attempt this 
one. 

Step 1: Type Q to access the Query menu. 

Step2: Type a to access the Load Query option. 

Step 3: Highlight the query named Operating Status, as it is 
in Exhibit 1-1. You have two ways to do so: 

• Use your [!]and [!] 
• Type the first few letters of the title: ~ 

Exhibit 1·1 

1'.l..i.a I &d:: I o~ .. :-; I &-,.;: I ==========WA:"ERS State Systerr.================= - -I· -
Select: ~uery:s1 :;: :.....:.d.: • ;~:.·t:r.te:---Hit Enter to Beg;.n .;-.Jery 
.I OPE '":ue:-v Header erat:oms I 
Al! Class 1: !r.=~· ... ::-3. ··:--.:s Cidss = :. Type at we:! F-er~1: 

All we: ls Opera::e:: '·• · - .... ;:s Opera~or 1 co:ita:ns ·~L?OJ• 
Op: !o!cb:: Operator 1 :on:.a::os "M02C4" 

GJ ~n1:~ st.o1.tus ~.raU-oQ: St:&'t.1ta h AOt: uipcy 
i--~~~~~~~~~~~~~~~~~~~~~-d rn 

Ru:e = Y Rule A~thor:zed conta::os •y• r:;i 

IJl .. ~ ......................................................... ced Re ~ 
·~ Appl::at;or. ::'rl: .. 
:......, Date Penn:: iss~~c 
·~ Date Perm!: ::::ec:.·~~ 
: Cate Perrr.::. ~cc:!:eo 
~I:() 7ype of ?er.,,1:. !-ice 

.0 Date P!ugged/Ata:o=o:oed ::s Con:r:e:-c1a~ ~de: l :~·1 N 

Tech.~1ca~ Review 
Public No:. ice 
Pub! :c Hearing 
Permit Term ;o Years 
Expirauon / / 

Date Permit Der:1e::l 
Date W1thdraw:i 

.._ ............................................................................................................ _,faun! 
lnC I Non-UI: IRe::odex All WATERS Budget Reference Tdtl~5 I 

Step 4: Press I Return I. As shown in Exhibit 1-2, two dialog 
boxes will appear in the middle of the screen, 
displaying : 

• Criteria for the query 

• Pass WATERS is on 
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• Amount of records processed 

• Total amount of records in the database 

• Amount of matches found so far. 

Exhibit 1·2 

Pi le 

Compl/En f Operations 

Explanation of Query Criteria 

Operating Status is not empty 

0 Wel ! lden:i !ier 
0 Date Updated 
0 Operating Status 
O Status E!fect~ve 
0 
0 
g Minimum 
0 Average 
0 Maximum 

0
0 

Annual Volume of 
!nj ected Fluid 

0 Fluid Type 

f I 
s·::1,·.iC 

l.'l 
45/ 472 
39 

<Esc> to Cancel 

OIC... Non-t:IC Query Menu 

Annulus Pressure 
I psig I 

Then WATERS shows the total number of records that 
match your query criteria. 

Step 5: Press any key to see the first of these records. 
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J. Deleting a 
Query 

When you want to delete one of your saved queries, 
use this option. For this example, you will build on 
the query in Section G and saved in Section H. Work 
through those sections before you attempt this one. 

Step 1: 

Step2: 

Step 3: 

Pile I Id!: 

Type Q to access the Query menu. 

Type D to select the Delete Query option. 

Highlight the query named Operating Status, as it is 
in Exhibit J-1. You have two ways to do so: 

• Use your ~ and [1J 
• Type the first few letters of the title: ope 

Exhibit J-1 

r ouery I Belp !==========WATERS State system================= - -1- -
Selec: Query Isl :o Deiete w/Ctr:-~•te,·-Hlt i::nte' to Begin Query 
.I' OPE OuQrv Header pera:~ons 

Ali Class 1: Jndividua'. Permits Class = 2. Type of Weil Permit 

~ Al: Weils Operated by Phi 11 ips Operator I contains "PLPQ)• -
Op: Mobil Operator I contains "MOB04" 

OJ ~ntU!J statu. ~%'U1Jlq st•t'WI ·is:#ot .._,ey 
d OJ 

Rule = y Rule Au:hcr1zed contains ·y· [!) .ced Re 

:=s Application Date I I Technical Review I I 
Date ?e!"ll'li t Issued I I ?ubl ic Notice I I 

:~ 
Date ?e~m1 t E!fec~ive i , ?ubl ic Hear;ng I I 
Date Pe:-m1: Mod1~1eC ·' i Perm1 t Tenn :o ·fears 

!:2 
Type of ~e:m1 t. Mod Expiration I I 

Date Plugged/Abandoned I I Date Permit Denied I I ::s Co!Tlnercia.l Facility N Date Withdrawn I I 

Po1iiil 

UIC 1 Non-UIC IQuery Men..i ( 

Step 4: Press I Return I. In the middle of the screen a pop­
up window will ask you to confirm that you want to 
delete this query. Type Y for yes. 
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K. Deleting a 
Record 

Step 1: 

Step 2: 

Step 3: 

Step 4: 

Appendix A WATERS Training Script 

The delete function enables you to permanently 
delete records from your database. In this example, 
you will delete a record from the MIT folder. 

Type M to access the MIT folder. 

Find the record you wish to delete. either through 
the List function or the Find function (sections F & G 
of this chapter. respettively). The Delete option 
deletes the record in the folder that is active on your 
screen. 

Type f to access the Edit menu. 

Type D to choose the Delete option. Your screen will 
look like Exhibit K-1 below. 

Exhibit K·1 

---p;;: ~~y 1-·. ~· c: "._ I I : ,•Pee:' o:i I I 
= Bd1c 

11 Compl!:Ji! I I NIT Operdt1ons 

- . ..-1><!;;.::•'-...._
4

?.,.-a-AN :;:. :p=f-E:':':ES -----------UT0235l 

~t Table 
te~:;.!.;.e-r 

~o:-d :.Opo.1: '!'d 

essed 
Inspect or N~~ ~;o 

Date/Res;Jl!. .:! :....a~ !-'::~ 

:..ast :orre~:;.ve ~c-:..=r-. 

Both P:s ":"-:: .:--i:::: ~'!:es: 
~ate/?es .. d: -:! U-a~ :e-s: 
":'ype of :..ect~ :es: 

~ate/Resu~t c! Fl~~c ~1~ :est 
Type o! flu•d X;~:a:•~r. Test 

Date of Re~ed1a'. Ac:;cr. 
Type of ~emed1a: Act:on 

... ;:on: l lllon-OIC !Delete ::urrent Record! 

UTn35l 
1990112/:2 
y 

Macho Enforce /645 
1967/06/15 Passed 

I I 

y N 
1990/03/14 Passed 
~as1n9/Tub1ng Pressure 

1990/03/15 Passed 
Current Record Review 

1989/01/23 
Tubing/Packer 

-

Steps: A pop-up window shown in Exhibit K-2 asks you to 
confirm that you want to delete this record. To 

choose Yes. type .Y or use the ~ and (B to 
highlight the yes option and press I Retum I. 

A-24 WATERS User Guide 



I 

Appendix A. WATERS Training Script 

Exhibit K·2 

============WATERS State Syste:n==================== 

Well Iden~f1er 

Date Record Updated 
MI'!' Witnessed 

:napect101 JUT 

UT02353 

1990/12/12 
y 

Inspector Name/Nr-o;:. =======H::::a:;:c:;:h;::o::;:E:;;n;:::fc:;::r:;:c;:::e=· ;::;6;'\4S 
Date/Result of 111 ed 
Last C'.lrra:t 1ve Are you sure you want to delete' 

I Tes I r.rriJ:Y=:=• 
Both Pts Tst crni:!Jiiiliiijiiiii:!iiiiiiiiiii~iilliiiii~ 
Date/Result of L -·· ·--- ... •. .. • . -- ed 
Type of Leak Test 

Date/Result of Fluid H1g Test 
Type of Fluid Higrat10n Test 

Date of Renedial Act 10n 
Type of Renedial Act ion 

,·lJlt:.· Son-UIC Edit Hen:.i 

Casing/~l.b1ng Pressure 

1990/03/15 Passed 
Current record Review 

1989/01 /23 
Tubing/ Pa:ker 

Deleting a record from the Permits folder works the 
same way. However, deleting the Permit record for 
a well automatically deletes all of that well' s records 
in the other folders. 
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L. Printing a 
Well Schematic 

Step 1: 

Step 2: 

Step 3: 

Appendix A. WATERS Training Script 

There are two ways to print a well schematic: 
through the Reports option of the Query menu, or 
you can print it while viewing one, which is what you 
will do in this example. 

Type Q to access the Query menu. 

Type W to access the Well Schematic option. 

At the top left comer of the well schematic, the 
record number of the current well will appear. 

Type P to print the well schematic. 

The word 'printing' will appear at the top of your 
screen. At the same time, screen colors will change: 
the confining zone turns white, and all the letters turn 
black. When the screen flashes and the 'printing' 
message disappears, your well schematic has 
finished printing. 
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M. EPA 7520 
Reports 

Step 1: 

Appendix A WATERS Training Script 

This option enables you to generate EPA 7520 
reports for your Class II wells. These reports are 
computer-generated facsimiles of the OMB­
approved EPA 7520 forms. You can generate EPA 
7520 reports from any folder. In this example, you 
will print a Permit Review and Issuance report (EPA 
7520-1 ). 

Type Q. to select the Query menu. 

Step2: Type R to access the Reports option. and a dialogue 
box appears with five windows. Each window is a 
consecutive step in completing a report. Exhibit M-1 
shows the Reports dialogue box. 

Exhibit M·1 

Pile lklit Query •elp 

=o 
:::::0 
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1111() 

?.epo:--:.s 

=o 
1111() 
=o 
=o 
=o 
:::::0 

-sclledul.• ll•port• -----. 

""'O 
:::::0 
:::::0 
:::::0 
=o 
=o 

:rnspection Scbedula 

llIT Schedule 

)@{#@~f.{~~ •on-UIC Query Menu 

ifir~~: 1;1st 
Sew/aod1fy Query 

clle4ul.• Pora 

~g~~h 
Year 
lst Quarter 
2nd Ou.orter 
lrd 8u11rter 
4th 1111rter 

Step 3: Type z to select 7520 reports. In the second window 
of the Reports dialogue box, all the 7 520 reports 
available are listed. 

Step 4: Type .E to choose the Permit Review and Issuance 
report. 

Step 5: WATERS then prompts you for the year. Type .122J 
and press I Return I . 
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Step 6: 

Step 7: 

Step 8: 

Step 9: 

Appendix A WATERS Training Script 

Press I Return I again. In a 7520 report, you cannot 
report on a subset of the wells in your database. 
You can only select a well range of All Wells. 

Next you are prompted for the time period within 
your selected year. To generate a report for the first 

quarter, type l or use the [!]and [!I to highlight the 
number 1. 

Press I Return I. You can only print 7520 forms, not 
view them on your screen or print them later. 

Your screen will look like Exhibit M-2. 

Exhibit M·2 

=============WATERS State System===================== 

elect a Jteport Typ.1 
Schedule Reports 
St at;;s Reports 
llnfcrcement Reports 
Mel: Bv well Reports 
Ilise. Reports 

Permit Review and Issuance 

~~~!Afg~y ~~~~~r£?n 
Kxceptions List (QuarterlyJ 
Qrant Utilization 

Reports 

11----... 
Current Wel I 
Current List 
Ai I We! ls 
New/modify Query 

A menu box in the lower left corner lets you approve 

the report or cancel it. Use your ~and (B to 
highlight OK and press I Return I. WATERS will now 
print the report. 
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N. Creating a 
Custom Report 

Step 1: 

Step2: 

Step 3: 

Appendix A. WATERS Training Script 

When you want to generate a report, check 
WATERS standard reports to see if one meets your 
reporting requirements. If not, you can create a 
customized report on fields you have entered data 
into in WATERS. 

These elements become the columns of your report, 
and the order in which you select them determines 
the order of the columns. In addition to choosing 
and ordering the data elements. you can build a 
query into the report. In this example, you will select 
elements of the Operations folder, and view only 
wells that have a value in the "Operating Status" 
field. 

Type 0 to move to the Operations folder. 

Type Q to access the Query menu. 

Type R to access the Reports option. Your screen 
will look like Exhibit N-1 below. 

Exhibit N-1 
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Step 4: 

Step5: 

Step 6: 

Step 7: 

Appendix A WATERS Training Script 

Select Misc. Reports by typing Mor press[!] and 

[!] to highlight Misc. Reports and press I Return 1. 

Select Custom Report by typing .C or press [!] and 

[!] to highlight Custom Report and press I Return I. 

Choose All Wells for the report range by typing A or 

press [!]and [!]to highlight All Wells and press 
I Return I, 

Choose the screen as the destination of the report. 

To do so, type .S. or press [!]and [!]to highlight 
Screen and press I Return I. Your screen should 
look like Exhibit N-2. 

Exhibit N·2 
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Step 8: 

Step 9: 

Step 10: 

Step 11: 

Step 12: 

Step 13: 

Appendix A. WATERS Training Script 

Press I Return I to select the OK box. You are now 
in the Operations folder, and the fields in which you 
can select as report columns and/or search are 
displayed in red. 

Move to the "Date Status Effective" field and press 

[Ei]. You have selected "Date Status Effective" as 
the second column in your custom report. You will 
see a 2 on the left side of the field. The first column is 
automatically the Well ID, as denoted by the 1 next 
to that field. 

Move to the "Operating Status" field. 

Type an asterisk (*) in the "Operating Status" field. 
This asterisks indicates that you want to select any 
record with a value in the status field. 

Press [Ei] to make the "Operating Status" field the 
third column of your report. A 3 will appear to the 
left of the field. 

Move to the "Date Updated" field and press [Ei]. 
Your screen should look like Exhibit N-3 below. 
Notice that the "Date Updated" has a 4 next to it. 

Exhibit N·3 

T Up Fld - ~ef< Char/Fld i'qDll Next Paoe Pl Help 
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F4 to add or re.,ove a f le Id fro"' Custo., Reporti Wldth 88 of 176 characters 
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Step 14: 

Step 15: 

Step 16: 

Appendix-A WATERS Training Script 

Press I Control I - W. A pop-up window displays 
three choices: Search, Clear, and Edit. Type S to 
begin the que: 1' for the custom report. 

While WATERS indicates that it is searching for 
matches and how far along in the process it is. 
V·-ihen the searcri is complete, the number of 
matches found will appear in a new pop-up 
window. Press any key to see your custom report. 

Notice that the report lists the data in columns with 
the field descriptions in the order you selected the 
fields: "Well Identifier", "Date Status Effective", 
"Operating Status", and "Date Record Updated". 
To navigate the report, use the command keys listed 
at the bottom of your screen. 

When you finish looking at the report, type f to exit. 
A pop-up window will give you the option to save 
the report. If you do not intend to use a report 
again. type N. If you do intend to use a report 
again. type .Y. and then name the report. You can 
use the Load Query option to retrieve and run this 
report. and the Delete Query option to delete it. 
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Appendix A. WATERS Training Script 

O. Quitting 
WATERS 

This function allows you to leave the WATERS system. 

Step 1: Type E to select the File menu. 

Step 2: Type Q to select the quit option. 

Exhibit 0·1 
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A pop-up window will ask you to confirm that you 

·want to quit. Use ~and ~ and press 
I Return I to select Yes. WATERS returns you to the 
c: \WATERS prompt. 
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Appendix 8. Data Dictionary 

Appendix B. WATERS Data 
Dictionary 

This appendix contains a list of all of the data 
elements included in WATERS. WATERS consists of 
five databases: 

• Permit 

• Inspection 

• Mechtest 

• Comply 

• Operate 

In general, the data elements are arranged in the 
databases according to the folder of which they are 
a part. However. the data elements in the Permit 
and Inventory folders are combined into one 
database (Permit). 

The columns are labelled as follows: 

FT: Field Type (N = Number, C = Character. and D = 
Date) 

FL: Field Length 

FD: Field Decimal (number of decimal points) 

R: Required Data Element (Y /N) 
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Appendix B. Data Dictionary 

No. Title FIELD_NAME FT FL FD R 

Calculated Fields 
1 Date of Last Corrective Action LAST CA CT D 8 0 
2 Date of Last MIT DATEMIT D 8 0 
3 Injection Interval A Net Feet ZONEAINT N 5 0 
4 Injection Interval B Net Feet ZONEBINT N 5 0 

5 Intervening Thickness of USDW INTVTHICK N 4 0 

6 Number of Wells per Permit APWN N 3 0 
7 Permit Term Description TERMDESC c 4 0 
8 Result of Last MIT RESULTMIT · c 1 0 
9 Thickness of Lower-most USDW THICKBLOCK N 4 0 

COMPLY 
1 Compl/Enf Well Identifier WELLID c 15 0 y 

2 Compliance Schedule Written CS WRITE c 1 0 
3 Date Compl/Enf Record Updated DATERU D 8 0 
4 Date Compl/Enf Withdrawn DWITHDRW D 8 0 
5 Date Compliance Required DATECR D 8 0 
6 Date Comply/Ent Anal DFINAL D 8 0 
7 Date Enforcement Action Taken DATEEAT D 8 0 y 

8 Date of Notification DATENOTE D 8 0 
9 Date Penalty Assessed DATEASSD D 8 0 
10 Date Penalty Collected DATECOLL D 8 0 
11 Date Returned to Compliance DATER ET D 8 0 
12 Date Vio Occurred/Verified DATOCCRD D 8 0 y 

13 Docket Number EAID c 15 0 
14 Last Compliance Result LCRESULT c 1 0 
15 Last Compliance Review LAST CR D 8 0 
16 Multiple Enforcement Actions MULTEA c 1 0 
17 Penalty Amount Assessed ASSESSED N 6 0 
18 Penalty Amount Collected COLLCTED N 6 0 
19 Significant Non-Compliance SNC c 1 0 
20 Type of Enforcement Action TYPEEAT c 2 0 y 

21 Type of Notification TYPENOTE c 2 0 
22 Type Vio Occurred/Verified TYPEVRFD c 2 0 y 

GUARNTR 
Guarantor Address GAD DR c 30 0 

2 Guarantor City GCITY c 15 0 
3 Guarantor Name GNAME c 30 0 
4 Guarantor Number GNUM c 5 0 y 

5 Guarantor Phone Number GPHONE N 10 0 
6 Guarantor State GSTATE c 2 0 
7 Guarantor Zip Code GZIP N 9 0 
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Appendix B. Data Dictionary 

No. Title FIELD NAME FT FL FD R 

INSPECT 
1 Action Taken ACTION c 2 0 

2 Complaint Resolution COMPLAINT c 20 0 

3 Date Inspection Retord Updated DATERU D 8 0 

4 Date of Inspection DATEINSP D 8 0 y 

5· Emergency Resolution EMERGENCY c 20 0 

6 Inspect Well Identifier WELLID · c 15 0 y 

- 7 Inspector Name INSPNAME c 20 0 

8 Time Required for EMR Resolut. ERTIME N 2 0 

9 Time Required for Resolution CRTIME N 2 0 

10 Type of Inspection TYPEINSP c 2 0 

11 Violation Discovered/Present VIOLATION c 0 

MAP 
1 Map Well Identifier WELLID c 15 0 y 

2 Type of Well TYPECODE N 2 0 

3 XCOORD for MAP data base XCOORD N 11 
4 YCOORD for MAP data base YCOORD N 11 

MECHTEST 
1 Both Point Tests Completed BPTCOMP c 1 0 
2 Both Point Tests Retest BP RETEST c 1 0 

3 Date MIT Record Updated DATERUP D 8 0 y 

4 Date of Fluid Migration Test DATEFMT D 8 0 
5 Date of Leak Test DATELT D 8 0 

6 Date of Remedial Action DATERA D 8 0 

7 Inspector Name INSPTNAME c 20 0 

8 ·MIT Well Identifier WELUD c 15 0 y 

9 MIT Witness MITWITNES c 0 

10 Result of Fluid Migration Test RESULTFMT c 0 
11 Result of Leak Test RESULTLT c 1 0 
12 Type of Fluid Migration Test TYPEFMT c 2 0 
13 Type of Leak Test TY PELT c 2 0 
14 Type of Remedial Action TYPE RA c 2 0 

NONUIC 
1 Comment Field COMl c 60 0 

2 Comment Field COM2 c 60 0 

3 Comment Field COM3 c 60 0 

4 Date Permit Effective EFFECTVE D 8 0 

5 Date Permit Issued ISSUED D 8 0 

6 Finds Number FINDS c 12 0 
7 Latitude LAT N 12 4 y 
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Appendix B. Data Dictionary 

No. Title FIELD NAME FT FL FD R 
8 Legal Contact LEGAL c 2 0 
9 Longitude LONG N 13 4 y 

10 NONUIC Well Identifier WELLID c 15 0 y 

11 Numeric Type of Facility NFACTYPE N 
12 Numeric Type of Permit NPERMTYPE N 1 
13 Operator Number OPNUM c 5 0 
14 Owner Number ONUM c S--0 
15 Permit Number PERMIT c 10 0 
16 Problems Field PROBl c 60 0 
17 Problems Field PROB2 c 60 0 
18 Problems Field PROB3 c 60 0 
19 Total Depth TDEPTH N 5 0 y 

20 Type of Facility FACTYPE c 2 0 
21 Type of Permit PERM TYPE c l 0 
22 Well Description WELLDESC c 30 0 
23 XCOORD XCOORD N 11 ' 
24 YCOORD YCOORD N 11 

OPERATE 
1 Annual Volume Injected Fluid IFLUID N 6 0 
2 Average Annulus Pressure APA VG N 4 0 
3 Average Injection Pressure IPAVG N 4 0 
4 Average Injection Rate IRAVG N 4 0 
5 Date Operation Record Updated DATEUPD D 8 0 
6 Date Status Effective DATESTAT D 8 0 y 

7 Maximum Annulus Pressure AP MAX N 4 0 
8 Maximum Injection Pressure IPMAX N 4 0 
9 Maximum Injection Rate IRMAX N 4 0 
10 Minimum Annulus Pressure APMIN N 4 0 
11 Minimum Injection Pressure IPMIN N 4 0 
12 Minimum Injection Rate IRMIN N 4 0 
13 Operate Well Identifier WELLID c 15 0 y 

14 Operating Status OPSTAT c 2 0 
15 Type of Fluid FLUIDTYPE c 2 0 

OPERATOR 
1 Operator Address OPADDR c 30 0 

2 Operator City OP CITY c 15 0 
3 Operator Contact OPCONTACT c 30 0 
4 Operator Name OP NAME c 30 0 
5 Operator Number OPNUM c 5 0 y 
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Appendix B. Data Dictionary 

No. Title FIELD_NAME FT FL FD R 
6 Operator Organization OPORG c 30 0 

7 Operator Phone Number OPHONE N 10 0 

8 Operator State OPSTATE c 2 0 

9 Operator Zip Code OPZIP N 9 0 

OWNER 
l Owner Address OADDR c 30 0 

2 Owner City OCITY c 15 0 

3 Owner Contact OCONTACT c 30 0 

4 Owner Name ONAME c 30 0 

5 Owner Number ONUM c 5 0 y 

6 Owner Organization OORG c 30 0 
7 Owner Phone Number OP HONE N 10 0 

8 Owner State OSTATE c 2 0 

9 Owner Zip Code OZIP N 9 0 

PERMIT 
l Above USDW Depth USDWDPTH N 4 0 

2 Above USDW Name USDWNAME c 20 0 

3 Above USDW TDS USDWTDS N 4 0 
4 Above USDW Thickness USDWTHCK N 4 0 
5 Accuracy of the Location ACCURACY N 3 0 

6 Altitude Date ALTDATE D 8 0 
7 Altitude Method ALT METH c l 0 
8 Amount of Coverage AMTCOY N 6 0 
9 Annulus Fluid ANNULUS c 2 0 
10 API Number API c 10 0 
11 . Application Date APPDATE D 8 0 

12 Base Depth of USDW IBASDPTH N 4 0 
13 Below USDW Depth USDWDTH2 N 4 0 
14 Below USDW Name USDWNAME2 c 20 0 
15 Below USDW TDS USDWTDS2 N 4 0 
16 Below USDW Thickness USDWTHK2 N 4 0 
17 Blanket Coverage BCOVER c 0 
18 Class CLASS N l 0 
19 Comment Field COMl c 60 0 
20 Comment Field COM2 c 60 0 
21 Comment Field COM3 c 60 0 
22 Commercial Facility (Y /Nt CFACILITY c 0 
23 Completion Type COMPLETET c 2 0 
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Appendix B. Data Dictionary 

No. Title FIELD_NAME FT FL FD R 
24 Confin Zone A Effect Porosity CZEPA N 3 0 

25 Confin Zone A Fracture Press. CZFPA N 4 0 
26 Confin Zone B Effect Porosity CZEPB N 3 0 
27 Confin Zone B Fracture Press. CZFPB N 4 0 
28 Confin Zone Geological Name A CZGNA c 20 0 
29 Confin Zone Geological Name B CZGNB c 20 0 

30 Con fin Zon~ Perm A( 1 Oth Power) CZPAlO N 3 0 
31 Confin Zone Perm B(lOth Power) CZPBlO N 3 0 
32 Confining Zone A From ACZONFRM N 5 0 
33 Confining Zone A Lithology CZLA c 20 0 
34 Confining Zone A To ACZONETO N 5 0 
35 Confining Zone B From BCZONFRM N 5 0 
36 Confining Zone B Lithology CZLB c 20 0 
37 Confining Zone B To BCZONETO N 5 0 
38 Confining Zone Permeability B CZPB N 4 0 
39 Confining Zone Permeat c / A CZPA N 4 0 
40 County of Well COUNTY c 3 0 
41 Date Demonstration Last Review DEM REV D 8 0 
42 Date of First Injection DATEIB D 8 0 
43 Date Permit Denied DENIED D 8 0 
44 Date Permit Effective EFFECTVE D 8 0 
45 Date Permit Issued ISSUED D 8 0 
46 Date Permit Modified MODIFIED D 8 0 
47 Date Permit Withdrawn WITHDRWN D 8 0 
48 Date Plugged/ Abandoned ABANDON D 8 0 
49 Date Well Drilled DATEWELL D 8 0 
50 Demonstration Expiration Date DEM EXP D 8 0 
51 Depth Measurement . DPTHMEAS c 0 
52 Depth of TDS DTDS N 4 0 
53 Description of the Well DESCRIBE c 20 0 
54 District of Well DISTRICT c 20 0 
55 Effective Porosity A EPA N 3 0 
56 Effective Porosity B EPB N 3 0 
57 Estimated Plugging Costs PLUGCOST N 6 0 
58 Exempted Aquifier A (Y /NJ ACFR c 0 
59 Exempted Aquifier B (Y /NJ BCFR c 0 
60 Facility Identification FACIO c 15 0 
61 Federal Land (Y /NJ FEDERAL c l 0 
62 Field Name FIELDX c 20 0 
63 Finds Number FINDS c 12 0 
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Appendix 8. Data D1cnonary 

No. Title FIELD_NAME FT FL FD R 
64 Flow Rate FRCODE c 0 
65 Fracture Pressure A FPA N 4 0 
66 Fracture Pressure B FPB N 4 0 
67 Frequency of MIT Tests MIT CODE c 2 0 
68 Guarantor Number GNUM c 5 0 
69 Indian Land (Y/N) INDIAN c l 0 
70 Inject Zone Geological Name A GNA c 20 0 
71 Inject Zone Geological Name B GNB c 20 0 
72 Injection Interval Bottom A AZONEBOT N 5 0 
73 Injection Interval Bottom B BZONEBOT N 5 0 
74 Injection Interval Top A AZONETOP N 5 0 
75 Injection Interval Top B BZONETOP N 5 0 
76 Injection Pressure IPCODE c 0 
77 Injection Pressure I PRESS N 4 0 
78 Injection Rate Measure IRATE N 4 0 
79 Injection Volume IV CODE c l 0 
80 Injection Zone A From AZONFROM N 5 0 
81 Injection Zone A To AZONETO N 5 0 
82 Injection Zone B From BZONFROM N 5 0 
83 Injection Zone B To BZONETO N 5 0 
84 Injection Zone Lithology A IZLA c 20 0 
85 Injection Zone Lithology B IZLB c 20 0 
86 Intermediate Casing Cemented I CEMENTED c 0 
87 Intermediate Casing Depth I DEPTH N 4 0 
88 Intermediate Casing Diameter IDIAMETR N 7 3 
89 Intermediate Casing Grade IGRADE c 4 0 
90 Intervening Thickness of TDS ITDS N 4 0 
91 Latitude/Longitude Date COORDDATE D 8 0 
92 Legal Contact LEGAL c 2 0 
93 Long String Casing Cement LSCEMENTD c 1 0 
94 Long String Casing Depth LS DEPTH N 4 0 
95 Long String Casing Diameter LS DIAM TR N 7 3 
96 Long String Casing Grade LSGRADE c 4 0 
97 Measuring Pnt of Surface Elev MEASPNT c l 0 
98 Method of Collection METHOD c 2 0 
99 Name of Lower-most USDW INAME c 20 0 
100 National Refer Datum for Alt NRDALT c 2 0 
l 01 Number of Wells Considered BC NWBC N 4 0 
102 OCZ Geological Name of A GNZONEA c 20 0 
103 OCZ Geological Name of B GNZONEB c 20 0 
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Appendix B. Data Dictionary 

No. Title FIELD_NAME FT FL FD R 
104 OCZ Total Thickness A ffiONEA N 4 0 
105 OCZ Total Thickness B ffiONEB N 4 0 
106 Operator Number OPNUM c 5 0 

107 Other Confining Zones Lith. 11. OCZON EA c 20 0 
108 Other Confining Zones Lith. B OCZON EB c 20 0 
109 . Owrier Number ONUM c 5 0 

1.10 Ownership of the Well OWNERSHIP c 2 0 
111 Packer (Y /N} PACKER c l 0 
112 Packer Depth PACKERD N 5 0 
113 Permeability A PA N 4 0 
114 Permeability A ( l Oth Power) PAlO N 3 0 
115 Permeability B PB N 4 0 
116 Permeability B (10th Power) PBlO N 3 0 
117 Permit Application Number APPNUM N 12 0 
118 Permit Expiration Date EXPIRE D 8 0 
119 Permit Number PERMIT c 10 0 
120 Permit Term TERM N 2 0 
121 Permit Well Identifier WELLID c 15 0 y 

122 Plug Back Total Depth PLUG BACK N 5 0 
123 Pub. Water Supply Wells in AOR PWS N 3 0 
124 Public Hearing Date PH DATE D 8 0 
125 Public Notice Date PNDATE D 8 0 
126 Quarter Four Q4 c 2 0 
127 Quarter One Ql c 2 0 
128 Quarter Three Q3 c 2 0 
129 Quarter Two Q2 c 2 0 
130 Range RANGE c 3 0 
131 Re~ion of Well REGION c 2 0 
132 Rule Authorized RULE c l 0 y 

133 Section SECTION c 2 0 
134 State of Well STATE c 2 0 
135 Surface Casing Cemented (Y /NJ SCEMENTED c 0 
136 Surface Casing Depth SDEPTH N 4 0 

137 Surf ace Casing Diameter SDIAMETR N 7 3 

138 Surface Casing Grade SGRADE c 4 0 

139 Surface Elevation SURFACE N 4 0 

140 TDS Method One TDSMETHOD c 2 0 
141 TDS Method Two TDSMETHD2 c 2 0 

• 
142 Technical Review Date TRDATE D 8 0 

143 Top Depth of USDW ITOPDPTH N 4 0 
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Appendix B. Data Dictionary 

No. Title FIELD NAME FT FL FD R 
144 Total Depth TDEPTH N 5 0 
145 Township TOWNSHIP c 3 0 
146 Tubing Depth TU DEPTH N 4 0 
147 Tubing Diameter TDIAMETR N 7 3 
148 Tubing Grade TGRADE c 4 0 

. ' 149 Type of Construction TYPECON c 2 0 
150 Type of Demonstration TDC ODE c 3- 0 
151 Type of Permit Modification MODCODE c 2 0 , 152 Type of Well TYPECODE c 4 0 
153 Type of Well Permit TYPEWELL c 0 
154 Type of Well Permitted WELLTYPE c 1 0 y 

155 Well Coordinates (Latitude) LAT N 12 4 
156 Well Coordinates (Longitude) LONG N 13 4 
157 Well Logs Run WELLLOG c 0 
158 Wellhead Protection Area (Y /N) WPA c 0 

QUERYDB 
1 Query Description QLOCEXP c 256 
2 Query Header QHEADER c 500 
3 Query Name QNAME c 40 

ADHOCDB 
1 Custom Report Description ALOCEXP c 256 
2 Custom Report Fields AFLDS c 256 
3 Custom Report Header AH EADER c 500 
4 Custom Report Name ANAME c 40 
5 Custom Report One Well Only AONE N 
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